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Présentation de Desktop Video

Le logiciel Desktop Video de Blackmagic Design fonctionne conjointement avec votre matériel UltraStudio,
DeckLink, Intensity ou Teranex. Ce logiciel inclut des pilotes, plug-ins et applications telles que Blackmagic
Video Utility et Media Express.

Ce manuel vous guidera a travers la configuration systéme requise, I'installation du matériel et du logiciel
ainsi que l'utilisation de votre logiciel tiers de prédilection.

Configuration systéme requise

L'ordinateur doit posséder au moins 4 GB de RAM. Les cartes PCle x 1 ligne devraient fonctionner dans
n'importe quel logement. Les cartes PCle x 4 lignes nécessitent un logement pouvant prendre en charge 4
lignes ou plus rapide. DeckLink 4K Extreme 12G nécessite un logement pouvant prendre en charge 8 lignes
ou plus rapide.

Mac OS X
Le logiciel Desktop Video est compatible avec les derniéres versions Mavericks et Yosemite de Mac OS X.

Si votre matériel vidéo Blackmagic Design se connecte a votre ordinateur via un logement PCl Express, un
Mac Pro muni de logements PCI Express appropriés est requis.

Si votre matériel vidéo Blackmagic Design se connecte a votre ordinateur via Thunderbolt, un Mac équipé
d'un port Thunderbolt™ est requis.

Windows
Desktop Video fonctionne exclusivement sur les versions 64 bits de Windows disposant du service pack le

plus récent. Windows 7, Windows 8 et Windows 10 sont pris en charge.

Si votre matériel vidéo Blackmagic Design se connecte a votre ordinateur via Thunderbolt, un PC équipé
d'un port Thunderbolt™ est requis.

Linux

Desktop Video fonctionne avec les ordinateurs x86 32 bits ou 64 bits sous Linux 2.6.23 ou version plus récente.
Veuillez vous référer aux notes de mise a jour pour obtenir la liste la plus récente des distributions, formats
de paquet et dépendances logicielles Linux compatibles.
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L'UltraStudio 4K et I'UltraStudio 4K Extreme sont dotés de
deux ports Thunderbolt 2™. Si votre ordinateur ne posséde
qu'un seul port Thunderbolt, vous pouvez utiliser le port
supplémentaire pour connecter un RAID ou un autre appareil.

Installez une carte PCle Blackmagic Design dans un logement
disponible. Une équerre HDMI peut étre installée dans
n'importe quel port libre et se connecte a l'arriére de la carte
au moyen des cables HDMI fournis.

Connecter du matériel vidéo avec un port Thunderbolt

Etape 1.
Etape 2.

Etape 3.

Etape 4.

Si votre matériel vidéo Blackmagic Design comprend une alimentation externe, connectez-la a
I'appareil et mettez ce dernier en marche.

Connectez un cable Thunderbolt entre I'appareil et le port Thunderbolt de votre ordinateur. Vous
pouvez également le connecter a la baie de stockage Thunderbolt de votre ordinateur.

Sile logiciel Desktop Video a été préalablement installé et vous propose une mise a jour du logiciel
interne, cliquez sur Update et suivez les instructions affichées a I'écran. Pour en savoir plus sur le
logiciel Blackmagic Desktop Video, consultez la section « Blackmagic Desktop Video Utility » de
ce manuel.

Siun céble épanoui est fourni, connectez-le au matériel vidéo Blackmagic Design et branchez les
connecteurs a votre équipement vidéo.

Connecter du matériel vidéo avec un port USB 3.0

Etape 1.

Etape 2.

Etape 3.

Etape 4.

Si votre matériel vidéo Blackmagic Design comprend une alimentation externe, connectez-la a
I'appareil et mettez ce dernier en marche.

Connectez un céable USB 3.0 SuperSpeed entre l'appareil et le port USB 3.0 dédié sur
votre ordinateur.

Sile logiciel Desktop Video a été préalablement installé et vous propose une mise a jour du logiciel
interne, cliquez sur Update et suivez les instructions affichées a I'écran. Pour en savoir plus sur le
logiciel Blackmagic Desktop Video, consultez la section « Blackmagic Desktop Video Utility » de
ce manuel.

Siun cable épanoui est fourni, connectez-le au matériel vidéo Blackmagic Design et branchez les
connecteurs a votre équipement vidéo.

Installer une carte PCle Blackmagic

Etape 1.

Etape 2.

Retirez la fiche secteur de votre ordinateur et assurez-vous que vous étes déchargé de toute
électricité statique.

Insérez votre carte PCle Blackmagic Design dans un logement approprié de votre ordinateur et
poussez-la fermement en place.

Veillez a ne pas endommager votre carte
PCle DeckLink lors de l'installation.
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Connectez le cable épanoui s'il a été fourni avec votre
carte Blackmagic Design. Certains modeles comprennent
également une équerre HDMI comme indiqué sur l'image
ci-dessus.

S'il vous faut une alimentation supplémentaire a celle fournie
par le logement PCle de votre ordinateur pour alimenter votre
DeckLink 4K Extreme 12G, utilisez le cable d'alimentation
fourni pour alimenter a la fois la carte graphique et votre
DeckLink 4K Extreme 12G.

Etape 3.

Etape 4.

Etape 5.

Si votre carte PCle Blackmagic Design comprend une équerre HDMI, insérez |'équerre dans un
logement disponible. Sécurisez la carte PCle et I'équerre HDMI avec des vis, passez les cables
HDMI autour des autres cartes installées et branchez-les a I'arriére de la carte DeckLink.

S'il vous faut connecter une alimentation externe a votre DeckLink 4K Extreme 12G, veuillez
consulter la section « Connecter une alimentation externe » de ce manuel.

Repositionnez le boitier de votre ordinateur, connectez les cables épanouis fournis et allumez
I'ordinateur.

Sile logiciel Desktop Video a été préalablement installé et vous propose une mise a jour du logiciel
interne, cliquez sur Update et suivez les instructions affichées a I'écran. Pour en savoir plus sur le
logiciel Blackmagic Desktop Video, consultez la section « Blackmagic Desktop Video Utility » de
ce manuel.

Connecter une alimentation externe

DeckLink 4K Extreme 12G fonctionne a des débits extrémement élevés et il se peut qu'une alimentation
supplémentaire a celle du logement PCl Express soit nécessaire. Si c'est le cas, vous pouvez utiliser le cable
d'alimentation fourni.

Pour alimenter votre DeckLink 4K Extreme 12G :

Etape 1.

Etape 2.

Etape 3.

Etape 4.

Etape 5.

Retirez la fiche secteur de votre ordinateur et assurez-vous que vous étes déchargé de toute
électricité statique.

Retirez le panneau latéral de votre ordinateur et vérifiez que I'unité d'alimentation de votre
ordinateur dispose d'un céble d'alimentation disponible. Si c'est le cas, connectez-le directement
a votre carte DeckLink.

Si les cables d'alimentation disponibles de votre unité d'alimentation sont déja utilisés par votre
carte graphique, il faudra utiliser le cable en Y pour alimenter a la fois votre carte graphique et la
carte DeckLink. Il vous suffit de déconnecter le cordon d'alimentation de votre carte graphique et
de le brancher au cable enY. La prise ne se connecte qu'un d'un cété, il est de ce fait impossible
d'effectuer un mauvais branchement.

Branchez a présent un des deux connecteurs du céble en Y a votre carte graphique et l'autre a
votre carte DeckLink. Les connecteurs sont compatibles avec les connexions a 6 ou 8 broches.
Votre carte graphique et votre carte DeckLink devraient a présent étre alimentées.

Remettez le panneau latéral de votre ordinateur en place et reconnectez I'alimentation.
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UltraStudio 4K Extreme est équipé d'un port PCle afin de
connecter une carte d'extension PCle externe installée sur
votre ordinateur.

i |
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La carte d'extension PCle est insérée dans le logement PCle
de votre ordinateur.

Le cable d'extension fourni est connecté au port PCle situé a
I'arriere de I'ordinateur.

Equiper I'UltraStudio 4K Extreme avec le standard PCle

Si votre workflow repose sur le standard PCle, ou si vous avez besoin d'une large bande passante pour
travailler en format 4K RVB 4:4:4, I'UltraStudio 4K Extreme prend en charge le PCl Express Gen 3. Pour utiliser
I'UltraStudio 4K Extreme avec le standard PCle, vous devrez commencer par installer un carte d'extension
PCle a votre ordinateur

Vous pouvez choisir d'acheter le kit de cables UltraStudio 4K Extreme PCle ou vous pouvez utiliser des cartes
et des cébles préts a I'emploi disponibles auprés d'autres fabricants. Le standard PCle est le méme pour
toutes les cartes d'extension. Elles seront donc toutes compatibles avec I'UltraStudio 4K Extreme. Installer
une carte d'extension PCle :

Etape 1.

Etape 2.

Etape 3.
Etape 4.

Etape 5.

Retirez la fiche secteur de votre ordinateur et assurez-vous que vous étes déchargé de toute
électricité statique.

Insérez votre carte d'extension PCle Blackmagic Design dans un logement approprié de votre
ordinateur et poussez-la fermement en place. Vissez les équerres de la carte PCle pour la
maintenir en place.

Repositionnez le boitier de votre ordinateur, branchez le cable d'extension PCle fourni entre le
port PCle de I'UltraStudio 4K Extreme et I'ordinateur.

Connectez le cable d'alimentation a I'UltraStudio 4K Extreme pour le mettre en route puis allumez
votre ordinateur.

Sile logiciel Desktop Video a été préalablement installé et vous propose une mise a jour du logiciel
interne, cliquez sur Update et suivez les instructions affichées a I'écran. Pour en savoir plus sur le
logiciel Blackmagic Desktop Video, consultez la section « Blackmagic Desktop Video Utility » de
ce manuel.
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Installer le logiciel Desktop Video

Applications, plug-ins et pilotes

Le tableau ci-dessous dresse une liste des applications, plug-ins et pilotes inclus lors de I'installation du

logiciel Desktop Video.

Mac OS X

Pilotes Blackmagic Desktop
Video

Blackmagic Desktop Video Utility
Blackmagic Design LiveKey
Blackmagic Media Express
Codecs Blackmagic QuickTime™

Blackmagic Disk Speed Test

Préréglages et plug-ins Adobe
Premiere Pro CC, After Effects
CC et Photoshop CC

Plug-ins Final Cut Pro™ X
Plug-in Avid Media Composer

Windows

Pilotes Blackmagic Desktop
Video

Blackmagic Desktop Video Utility
Blackmagic Design LiveKey
Blackmagic Media Express

Codecs Blackmagic AVI et
QuickTime™

Blackmagic Disk Speed Test
Préréglages et plug-ins Adobe
Premiere Pro CC, After Effects
CC et Photoshop CC

Plug-in Avid Media Composer

Linux

Pilotes Blackmagic Desktop
Video

Blackmagic Desktop Video Utility

Blackmagic Media Express
Codecs Blackmagic AVI
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Programme d'installation Desktop Video pour Mac

Programme d'installation Desktop Video pour Windows

Installation sur Mac OS X

Avant de pouvoir installer le moindre logiciel, il vous faut bénéficier des privileges d'administrateur.

Etape 1.
Etape 2.

Etape 3.
Etape 4.

Assurez-vous de disposer du dernier pilote. Consultez www.blackmagicdesign.com/fr/support

Lancez le programme d'installation Desktop Video a partir du support inclus a votre matériel ou
a partir d'une image disque téléchargée.

Cliquez sur les touches Continue, Agree et Install pour installer le logiciel.

Redémarrez votre ordinateur pour activer les nouveaux pilotes du logiciel.

Mises a jour automatiques

Lors du redémarrage de votre Mac, le logiciel vérifiera la version du logiciel interne de votre matériel.
Si la version du logiciel interne ne correspond pas a la version du pilote, il vous sera demandé de mettre le
logiciel interne a jour. Cliquez sur OK pour commencer la mise a jour et redémarrez votre Mac pour mener
a bien l'opération.

Installation sur Windows

Etape 1.
Etape 2.
Etape 3.

Etape 4.

Etape 5.

Assurez-vous de disposer du dernier pilote. Consultez www.blackmagicdesign.com/fr/support
Quvrez le dossier intitulé « Desktop Video » et lancez le programme d'installation « Desktop Video ».

Les pilotes s'installent a présent sur votre systéeme. Une alerte vous demandant de confirmer
I'installation du logiciel sur votre ordinateur va s'afficher : « Voulez-vous autoriser le programme
suivant a apporter des modifications a cet ordinateur ». Cliquez sur Oui pour continuer.

Une boite de dialogue apparait ensuite pour vous informer qu'un nouvel appareil a été détecté
et I'assistant Ajout de nouveau matériel détecté s'affiche. Sélectionnez I'installation automatique
et le systéme détectera les pilotes Desktop Video requis.

Siun appareil DeckLink Quad 2 est installé sur un ordinateur Windows 7, Windows Update vérifiera
chaque pilote pour trouver des versions plus récentes. Dans ce cas, cette action n'est pas nécessaire,
car tous les pilotes installés sur la derniére version de Desktop Video sont les plus récents. Vous
pouvez momentanément désactiver cette fonction en cliquant sur « Ne pas obtenir de logiciels
pilotes a partir de Windows Update ». Cliquez sur Oui pour confirmer votre choix. Linstallation
va s'effectuer trés rapidement.

Une fois tous les pilotes installés, une boite de dialogue indique qu’un nouveau périphérique est
prét a étre utilisé. Redémarrez votre ordinateur pour activer les nouveaux pilotes du logiciel.

Mises a jour automatiques

Lors du redémarrage de votre ordinateur, le logiciel vérifiera la version du logiciel interne de votre matériel.

Si la version du logiciel interne ne correspond pas a la version du pilote, il vous sera demandé de mettre le

logiciel interne a jour. Cliquez sur OK pour commencer la mise a jour et redémarrez votre ordinateur pour
mener a bien l'opération.


http://www.blackmagicdesign.com/fr/support
http://www.blackmagicdesign.com/fr/support
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Le logiciel Desktop Video est prét a étre installé a partir
de I'Ubuntu Software Center.

Installation sur Linux

Etape 1. Téléchargez la derniére version du logiciel Desktop Video pour Linux sur www.blackmagicdesign.
com/fr/support

Etape 2. Ouvrez le dossier Desktop Video et choisissez le paquet en fonction de votre distribution et
architecture. Veuillez noter que 'amdé4' est utilisé par les processeurs Intel et AMD 64 bits. I
existe trois types de paquets :

* Le paquet desktopvideo fournit les pilotes principaux et les bibliothéques API.
* Le paquet desktopvideo-gui fournit le logiciel Desktop Video Utility.
* Le paquet mediaexpress fournit un simple utilitaire d'acquisition et de lecture.

Etape 3. Double cliquez sur les paquets que vous souhaitez installer et suivez les instructions qui s'affichent.
Si des messages concernant des dépendances manquantes s'affichent, vérifiez tout d'abord gqu'elles
ont bien été installées et exécutez de nouveau le programme d'installation Desktop Video.

Etape 4. Lorsquele programme d'installation est installé, il est recommandé de redémarrer votre ordinateur
pour terminer l'installation.

Sivous ne trouvez pas de paquet natif Desktop Video pour votre distribution Linux, ou si vous préférez effectuer
I'installation a partir d'une ligne de commande, consultez le fichier ReadMe afin d'obtenir des instructions
d'installation plus détaillées.

Mises a jour

Sivous avez installé les utilitaires graphiques, vous serez automatiquement informé lorsque vous devrez mettre
a jour le logiciel interne. Lors du redémarrage de votre ordinateur, le logiciel vérifiera la version du logiciel
interne de votre matériel. Si la version du logiciel interne ne correspond pas a la version du pilote, il vous sera
demandé de mettre le logiciel interne a jour. Cliquez sur OK pour commencer la mise a jour et redémarrez
votre ordinateur pour terminer |'opération.

Sivous n'avez pas installé les utilitaires graphiques, vous pouvez vérifier si le logiciel interne est a jour a l'aide
de la ligne de commande du BlackmagicFirmwareUpdater :

# BlackmagicFirmwareUpdater status

Le message suivant apparait (ou similaire) :

0 /dev/blackmagic/io0O [DeckLink SDI4K] 0x73 OK

1. /dev/blackmagic/iol [DeckLink 4K Extreme 12G] OxOA PLEASE_UPDATE

Dans ce cas de figure, le logiciel interne peut étre mis a jour a l'aide de la ligne de commande suivante :

# BlackmagicFirmwareUpdater update 1

Veuillez consulter la page « man » pour obtenir une description plus détaillée sur |'utilisation de la ligne de

commande, par exemple, pour plus d'informations sur la ligne de commande concernant 'outil de mise a
jour du logiciel interne, saisissez « man BlackmagicFirmwareUpdater ».


http://www.blackmagicdesign.com/fr/support
http://www.blackmagicdesign.com/fr/support
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Camera Outputs

HDMI OUT
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Connectez un moniteur vidéo et une source a votre matériel
vidéo Blackmagic Design.

Cliquez sur le bouton Capture pour commencer
I'enregistrement.

Capturer et lire de la vidéo

Il est judicieux d'effectuer un test rapide pour vous assurer que vous arrivez a capturer et a lire de la vidéo.

Installation

Etape 1. Connectez un moniteur ou un téléviseur & la sortie vidéo de votre matériel vidéo Blackmagic Design.

Etape 2. Connectez une source vidéo a I'entrée de votre matériel vidéo Blackmagic Design.

Tester la capture vidéo

Etape 1. Ouvrez Blackmagic Media Express. Cliquez sur I'onglet Log and Capture. Le format de votre entrée
vidéo est automatiquement détecté et Media Express fait correspondre ce dernier au format vidéo
du projet. Votre source vidéo apparait dans la fenétre de prévisualisation de Media Express.

Etape 2. Cliquez sur Capture au bas de la fenétre Log and Capture pour effectuer un test de capture.
Cliquez sur le méme bouton pour terminer le test. Le clip capturé est ajouté a la liste de médias
sur le coté gauche de Media Express.

Tester la lecture vidéo
Etape 1. Cliquez sur I'onglet Playback.

Etape 2. Double-cliquezsurle clip test. La vidéo et I'audio seront envoyés au moniteur connecté a la sortie
de votre matériel.
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Pour capturer de la vidéo en H.265 avec le Blackmagic
UltraStudio 4K Extreme, réglez le format du fichier sur MP4
H.265 dans les préférences de Media Express.

Pour régler le débit binaire de la vidéo compressée en
H.265, appuyez sur le bouton Quality et déplacez le curseur
Encoding settings vers la gauche ou vers la droite.

Capturer de la vidéo H.265 avec UltraStudio 4K Extreme

Blackmagic UltraStudio 4K Extreme intégre un encodeur matériel H.265 qui permet de capturer de la vidéo
et de la diffuser au format de compression H.265 en temps réel. Cette norme de compression conserve une
qualité d'image trés élevée a un trés faible débit binaire.

Capturer de la vidéo a l'aide de I'encodeur H.265 intégré :

Etape 1. Ouvrez le logiciel Blackmagic Media Express. Ouvrez le menu Preference de Media Express et
réglez le parameétre Capture file format sur MP4 H.265.

Etape 2. Pour régler le débit binaire de la vidéo compressée en H.265, appuyez sur le bouton Quality
et déplacez le curseur Encoding settings vers la gauche ou vers la droite. Fermez la fenétre
Encoding settingss pour confirmer ce réglage. Blackmagic UltraStudio 4K Extreme est désormais
prét a compresser de la vidéo en H.265 a 'aide de Blackmagic Media Express. Pour obtenir des
informations sur la capture et la lecture vidéo, consultez la section Blackmagic Media Express de
ce manuel.

Régler le débit binaire

Le débit binaire par défaut est réglé sur 15 Mb/s, un choix approprié pour la diffusion en ligne de vidéos en
Ultra HD. Il peut cependant étre réglé entre 3 et 50 Mb/s. Pour le streaming en ligne de vidéos en HD, un
débit entre 3 et 5 mb/s est suffisant.

Déplacez le curseur vers la droite si vous voulez capturer des fichiers de grande taille et ainsi obtenir des
vidéos de trés bonne qualité. En général, lorsqu’on choisit un débit binaire faible, des défauts de compression
tels que la pixellisation ou les effets de bande apparaissent sur I'image. Choisir un débit binaire faible fera
apparaitre des défauts de compression sur l'image, tels que la pixélisation ou les effets de bande. Cependant,
I'encodeur matériel H.265 est trés efficace et réduit au maximum les défauts de l'image. Le débit binaire peut
donc étre faible tout en conservant une qualité d'images exceptionnelle.

Lorsque I'on compresse de la vidéo en H.265 (ou autre) pour le streaming online, il estimportant de considérer
les paramétres suivants : la bande passante des canaux de diffusion, la quantité de mouvements et de contrastes
entre les images et la fréquence d'images de la vidéo. Par exemple, si beaucoup de gens regardent la vidéo
en ligne, vous pouvez choisir de réduire le débit binaire pour que les internautes dont la connexion internet
est lente puissent télécharger le contenu sans probléme. Le choix d'un débit plus élevé est utile pour les
vidéos comprenant une grande quantité de contrastes et de mouvements entre les images, par exemple
le passage d'une image lumineuse a une image sombre ou les événements sportifs et les graphiques. Les
vidéos dont la fréquence d'images est élevée nécessitent des débits binaires plus élevés que celles dont la
fréquence d'images est basse.

Choisir un débit binaire approprié pour obtenir le meilleur rapport entre la qualité et la taille de la vidéo
nécessitera sans doute plu-sieurs essais. |l est important de tester plusieurs débits afin d'optimiser
votre utilisation.
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Page d'accueil du Blackmagic Desktop Video Utility.

Blackmagic Desktop Video Utility vous permet de modifier
les paramétres des entrées et des sorties vidéo et audio,
d'effectuer des up/down-conversions durant l'acquisition et la
lecture et fournit des informations sur le pilote.

Blackmagic Desktop Video Utility

L'utilitaire Blackmagic Desktop Video Utility permet de configurer les paramétres du matériel et affiche en
temps réel la vidéo connectée aux entrées et aux sorties de votre matériel.

Pour ouvrir |'utilitaire Blackmagic Desktop Video Utility :

Sur Mac OS X, cliquez sur Blackmagic Desktop Video dans les préférences systeme ou ouvrez
['utilitaire a partir du dossier Applications.

Sur Windows 7, cliquez sur Démarrer>Tous les programmes>Blackmagic Design>Desktop Video,
puis cliquez sur l'application Blackmagic Desktop Video Utility. Vous pouvez également ouvrir
I'utilitaire Desktop Video a partir du panneau de configuration de Windows 7.

Sur Windows 8, saisissez Blackmagic sur la page d'accueil, puis cliquez sur l'application Blackmagic
Desktop Video Utility. Vous pouvez également ouvrir |'utilitaire Desktop Video a partir du panneau
de configuration de Windows 8.

Sur Windows 10, cliquez sur Démarrer>Tous les programmes>Blackmagic Design>Desktop Video,
puis cliquez sur 'application Blackmagic Desktop Video Utility. Vous pouvez également ouvrir
I'utilitaire Desktop Video a partir du panneau de configuration de Windows 10.

Sur Linux, allez sur Applications puis sur Son et vidéo et double-cliquez sur l'application
Blackmagic Desktop Video Utility.

Lorsque vous ouvrez |'utilitaire Blackmagic Desktop Video Utility pour la premiere fois, la page d'accueil affiche
le matériel connecté et fournit un apercu de I'activité vidéo sur les entrées et les sorties de votre matériel.
Si vous envoyez un signal vidéo vers une entrée, il sera automatiquement détecté et son format sera affiché
sous l'icéne représentant l'entrée vidéo.

Si plusieurs appareils d'acquisition et de lecture Blackmagic sont connectés, vous pouvez les faire défiler en
cliquant sur les boutons directionnels situés sur les cétés de la page d'accueil. Pour configurer des paramétres,
il suffit de cliquer sur I'image du matériel ou sur l'icéne de paramétrage située au-dessous du nom du matériel.
L'utilitaire Desktop Video n'affiche que les paramétres pertinents pour le matériel sélectionné, vous ne devez
ainsi pas naviguer sur de nombreuses pages de menus pour trouver les paramétres recherchés.

Les pages suivantes de ce manuel vous indiqueront comment modifier les paramétres a l'aide de 'utilitaire
Blackmagic Desktop Video Utility.
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Cliquez sur une des icénes pour choisir la connexion de
I'entrée vidéo.

Cochez la case pour enregistrer le timecode a partir de
I'entrée XLR dédiée.

Déplacez les curseurs pour régler les niveaux de chroma et de
luminance sur la vidéo analogique.

Réglez le format de sortie pour qu'il corresponde a celui de
votre projet dans Final Cut Pro X.

Utilisez les Paramétres SDI pour contréler la sortie de votre
vidéo SDI.

Choose whether to output via single link, dual link or quad link
for 3G, 6G and 12G-SDI video signals.

Parameétres Vidéo

Entrée vidéo

Cliquez sur I'une des icdnes d'un connecteur pour configurer la connexion de I'entrée vidéo de votre matériel
Blackmagic Design. Seuls les connecteurs intégrés au matériel seront affichés. Lorsqu'un signal vidéo valable est
détecté, l'entrée et les formats vidéos sont affichés sur la page d'accueil du Blackmagic Desktop Video Utility.

Utilisez le timecode XLR

Sélectionnez ce paramétre pour lire le timecode a partir de I'entrée XLR au lieu du flux SDI.

Niveaux d'entrée vidéo analogique

Ajustez les curseurs 'vidéo' et 'chroma’ pour régler les niveaux d'entrée vidéo analogique de la vidéo composite
et composante. La modification des curseurs vidéo influence le luma gain et les curseurs chroma permettent
d'augmenter et de réduire la saturation des couleurs. Lorsque vous utilisez de la vidéo composante, vous pouvez
régler les valeurs Cr et Cb de fagon indépendante. Cliquez sur l'icone 'link" pour les régler simultanément.

Sortie vidéo

Pour effectuer du monitoring broadcast avec Final Cut Pro X, configurez le format vidéo qui correspond a
celui de votre projet Final Cut Pro X.

Parameétres SDI : Comprend des paramétres qui permettent de contrdler le signal vidéo SDI.

* 1080PsF On : Cochez cette case pour acheminer des images segmentées progressives.

* Remove Field Jitter On Pause : Cochez cette case pour éliminer le jitter de la trame lorsque
de la vidéo entrelacée est mise en pause sur les vieux moniteurs CRT. Cette option n'est pas
recommandée pour les écrans plats récents.

* 4:4:4 RGB : Cochez cette case pour acheminer de la vidéo RVB 4:4:4.

» Use SDI Level A : Cochez cette case pour acheminer les signaux SDI 3Gb/s en tant que
mappage SMPTE de Niveau A. Si cette case n'est pas cochée, les signaux 3Gb/s seront envoyés
via le mappage de Niveau B. Ce parametre influence uniquement la sortie, car le mappage SDI de
Niveau A et B est détecté automatiquement sur l'entrée.

Configuration SDI : Choisissez entre les options Single Link, Dual Link et Quad Link pour la sortie 3G, 6G
ou 12G-SDI. Certains moniteurs et projecteurs d'étalonnage professionnels ne prennent en charge que les
signaux a haute bande passante tels que le 2160p60 ou le DCI 4K 4:4:4 via quad link. UltraStudio 4K Extreme
peut acheminer des signaux 3G-SDI quad link. Vous pouvez également ajouter une carte Quad SDI au
DeckLink 4K Extreme 12G.
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Idle output permet de sélectionner l'affichage de la sortie
vidéo lorsque les vidéos ne sont pas en cours de lecture. Vous
pouvez choisir d'acheminer le noir ou les derniéres images
affichées pendant la lecture.

Cliguez sur une des icones pour régler le format de sortie
HDMI 3D.

Ajustez les curseurs vidéo pour régler la sortie vidéo
analogique composite et les curseurs Cr et Cb pour contréler
la balance des couleurs avec la vidéo composante.

Cochez la case Use Betacam Levels si vous travaillez avec des
magnétoscopes Betacam SP de Sony. Choisissez le niveau IRE
pour le format vidéo composite NTSC.

Régler la sortie vidéo analogique

Sivotre matériel Blackmagic Design dispose de connecteurs vidéo analogique partagés, vous pouvez choisir

d'acheminer votre vidéo via les signaux composante, composite ou S-Video a l'aide des options de sélection

sous Analog video output.

Idle Output : Utilisez ce paramétre pour choisir ce qui sera affiché sur la sortie vidéo lorsque la vidéo est en lecture.
» Black : Envoie des images noires vers les sorties.

= Last Frame Shown : Achemine la derniére image du clip ou de la séquence lue.

HDMI 3D Output : Ce parameétre détermine le mode 3D de votre monitoring HDMI.
+ Frame Packing : Combine les vues gauche et droite en une seule image sans compression.
» Line by Line : Les vues gauche et droite sont entrelacées ligne par ligne sans compression.
» (il gauche : Seules les images de I'ceil gauche sont affichées.
» (il droit : Seules les images de |'ceil droit sont affichées.
+ Side by Side : Les vues gauche et droite sont placées horizontalement avec une compression de 50%.

* Top to Bottom : Les vues gauche et droite sont placées verticalement avec une compression de 50%.

Niveaux de la sortie vidéo analogique

Faites glisser les curseurs 'vidéo' et 'chroma' pour régler les niveaux d'entrée vidéo analogique de la vidéo
composite et composante. La modification des curseurs vidéo influence le luma gain et les curseurs chroma
permettent d'augmenter et de réduire la saturation des couleurs. Lorsque vous utilisez de la vidéo composante,
vous pouvez régler les valeurs Cr et Cb de facon indépendante. Cliquez sur I'icone 'link' pour les relier si vous
voulez les régler simultanément.

Use Betacam Levels: Les produits Blackmagic Design utilisent les niveaux vidéo analogique composante
SMPTE pour offrir une compatibilité avec les équipements vidéo les plus récents. Cochez cette case si vous
utilisez des magnétoscopes Betacam SP de Sony.

NTSC IRE: Configurez le niveau de noir sur 7,5 IRE pour la vidéo composite NTSC utilisée aux Etats-Unis et
dans d'autres pays. Sélectionnez le paramétre O IRE si vous travaillez au Japon ou dans des pays qui n'utilisent
pas la configuration 7,5 IRE. Ce paramétre n'est pas applicable pour les formats PAL et haute définition.
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Si le signal de synchronisation est verrouillé, réglez ce
paramétre pour que la sortie vidéo soit synchronisée avec
I'entrée de référence.

Lorsqu'un DeckLink Quad 2 est installé, le paramétre
Connector Mapping vous permet d'attribuer des connecteurs
SDI a chaque appareil DeckLink Quad.

Entrée de référence

Le réglage de I'entrée de référence vous permet de synchroniser les sorties vidéo de votre matériel en fonction
del'entrée de référence vidéo. Ce systeme est largement répandu au sein des grandes installations broadcast
ou la sortie vidéo doit étre synchronisée de fagon précise. Le réglage de l'entrée de référence est effectué
en unités d'échantillonnage afin d'obtenir un réglage extrémement précis.

Par exemple, vous pourriez utiliser ce paramétre avec le matériel de votre installation disposant d'une
référence commune stable connectée pour que les sorties vidéo soient parfaitement synchronisées. Ceci
rend la commutation possible entre les appareils a I'aide d'une grille de commutation ou d'un mélangeur de
production en aval, éliminant ainsi tout défaut pendant la commutation.

Mappage de connecteurs pour DeckLink Quad 2

Si un appareil DeckLink Quad 2 est installé sur votre ordinateur, vous pouvez envoyer et acheminer les
signaux SDI sur 8 mini connecteurs BNC indépendants. Cela vous permet de capturer et de lire 8 flux vidéo
indépendants sur un seul appareil, exactement comme si vous disposiez de 8 appareils d'acquisition et de
lecture distincts. Comme le DeckLink Quad 2 apparait sur Desktop Video Utility en tant que 8 appareils
distincts, il est également plus facile de configurer les entrées et les sorties. Si vous le souhaitez, vous pouvez
renommer chaque appareil afin de savoir a tout moment quel DeckLink Quad est utilisé avec quel signal vidéo.

Les connecteurs SDI peuvent étre assignés a chaque appareil en vous aidant des parametres du Connector
mapping de |'utilitaire Desktop Video, mais il est important de savoir que certains connecteurs sont dédiés
a certains appareils. Par exemple, SDI 1 est dédié a DeckLink Quad (1), et SDI 2 est dédié a DeckLink Quad
(1) et DeckLink Quad (5.)

Il est facile de savoir quel connecteur SDI est dédié a quel DeckLink Quad a l'aide du tableau ci-dessous.
Vous y trouverez également les options de mappage.

Options de mappage
Appareils DeckLink Quad Connecteurs SDI dédiés
SDI1et?2
DeckLink Quad (1) ou
SDI1
SDI 3 et4
DeckLink Quad (2) ou

SDI 3
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Options de mappage (suite)

Appareils DeckLink Quad Connecteurs SDI dédiés

SDI5et6
DeckLink Quad (3) ou

SDI'5

SDI7 et8
DeckLink Quad (4) ou

SDI 7

SDI 2
DeckLink Quad (5) ou

aucun

SDI 4
DeckLink Quad (6) ou

aucun

SDI 6
DeckLink Quad (7) ou

aucun

SDI 8
DeckLink Quad (8) ou

aucun

Il est important de mentionner que lorsque vous configurez un connecteur SDI pour un appareil spécifique,
I'appareil qui partage ce connecteur sera également affecté. Par exemple, si DeckLink Quad (1) est réglé sur
SDI 1 et 2, DeckLink Quad 5 sera automatiquement réglé sur Aucun car le connecteur SDI partagé est en cours
d'utilisation. De plus, si DeckLink Quad (5) est réglé sur SDI 2, DeckLink Quad 1 sera automatiquement réglé
sur SDI 1. Il est donc important de savoir quelles entrées ou sorties SDI sont utilisées par chaque appareil afin
d'éviter d'interrompre accidentellement le signal d'entrée ou de sortie d'un autre appareil.

Si vous avez installé un DeckLink Quad d'origine dans votre studio et que vous utilisez une application qui a
été personnalisée a l'aide d'un SDK, vous savez que le DeckLink Quad 2 fonctionnera au sein de votre systéme
sans avoir a apporter de changements a votre application. Les fonctions de mappage complémentaires de
votre DeckLink Quad 2 vous permettront d'ajouter plus de configurations d'entrée et de sortie a votre systeme
existant selon vos besoins.
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Cliquez sur une des icdnes d'un connecteur pour configurer
la connexion de l'entrée audio

Faites glisser le curseur Output level pour contréler le niveau
de sortie numérique AES/EBU.

Ajustez les curseurs du canal d'entrée pour contréler les
niveaux d'entrée audio analogique. Cochez la case Use HiFi
Audio Levels si vous connectez du matériel audio grand
public.

Déplacez le curseur Input Level pour contréler le niveau
d'entrée de votre micro

Ajustez les curseurs du canal de sortie pour contréler les
niveaux d'entrée audio analogique.

Parameétres Audio

Entrée audio

Cliquez sur I'une des icénes d'un connecteur pour configurer la connexion de I'entrée audio de votre matériel
Blackmagic Design. Vous pouvez choisir entre les entrées suivantes :

* Embedded : les canaux audio sont intégrés aux signaux vidéo. Les signaux SDI et HDMI peuvent
transporter les signaux audio intégrés.

= AES/EBU : signal audio numérique pouvant transporter 2 canaux audio a |'aide d'un seul connecteur.

* XLR : connecteur audio composé de 3 broches principalement utilisé par les équipements audio
analogique professionnels.

= RCA ou HIFI : connecteur permettant de relier de |'audio analogique asymétrique a des
équipements audio grand public, tels que les systemes HiFi, les lecteurs DVD et les télévisions.

* Microphone : Lalimentation fantdme fournit de I'alimentation électrique via les cables pour
microphone. C'est une source d'alimentation trés pratique pour les microphones a condensateur.

Activez I'option « Use +48V phantom power » si I'alimentation fantdme est nécessaire pour votre
microphone. Sivous n'en étes pas certain, il est préférable de ne pas cocher cette case car cela
peut abimer les microphones autonomes. Un voyant LED, situé sur la fagade de UltraStudio 4K
Extreme s'allume lorsque I'alimentation fantéme est active. Il vous faut attendre au moins 10
secondes pour que l'alimentation fantdme se décharge apreés la déconnexion avant de brancher
un microphone autonome. Les microphones plus anciens tels que les microphones a ruban et les
microphones dynamiques ne prennent pas en charge |'alimentation fantdme.

AES/EBU

Faites glisser les curseurs pour régler les niveaux 'ref' ou le gain des entrées ou sorties audio AES/EBU. Cliquez
sur l'icdne de réinitialisation pour remettre le gain a 0 dB.

Niveaux de I'entrée audio analogique

Channel 1/Channel 2 : Ces paramétres ajustent la puissance du gain des entrées audio analogique pendant
I'enregistrement. Cliquez sur l'icdne 'link' pour les régler simultanément.

Use HiFi Audio Levels : Les modéles UltraStudio et DeckLink sont dotés de connecteurs XLR standard.
Si vous souhaitez connecter un équipement audio grand public a des connecteurs XLR, cochez la case Use
HiFi Audio Levels car les niveaux audio entre les équipements grand public et professionnels différent. Vous
aurez également besoin d'utiliser un adaptateur RCA vers XLR.
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Pour régler les paramétres des up et down-conversions,
sélectionnez I'entrée et la sortie de conversion a |'aide du
menu déroulant, et cliquez sur le format d'image que vous
souhaitez. N'oubliez pas de cliquer sur Save pour enregistrer
les parametres.

Niveaux de la sortie audio analogique

Channel 1/Channel 2 : Ces paramétres ajustent la puissance des signaux audio ou du gain des sorties audio
analogique pendant la lecture de la vidéo. Cliquez sur 'icdne 'link' pour les régler simultanément.

Icone de réinitialisation

Lorsque vous ajustez les curseurs, vous pouvez choisir d'annuler les changements. L'icone de réinitialisation
estreprésentée par une fléche circulaire située a droite de la barre de titre des paramétres. Cliquez sur l'icéne
de réinitialisation dans chacun des paramétres pour remettre le gain a 0 dB.

Parameétre de conversion

Entrée de conversion

Ce paramétre permet d'effectuer des up et down-conversions en temps réel pendant l'enregistrement.
Choisissez la conversion que vous souhaitez sur le menu déroulant Input conversion.

L'entrée de conversion ajoute jusqu'a 2 images de décalage, vous devrez donc ajuster le timecode de votre

logiciel de montage pour garantir une précision a l'image prés.

Display As : Sélectionnez la facon dont vous aimeriez afficher la vidéo convertie. En fonction du format de
I'image originale de l'entrée vidéo, l'affichage peut étre aux formats letterbox, anamorphique, center cut,
pillarbox, zoom 16:9 ou 14:9.

Sortie de conversion

Ce paramétre permet d'effectuer des up et down-conversions en temps réel pendant la lecture. Choisissez
la conversion que vous souhaitez dans le menu déroulant.

La sortie de conversion ajoute jusqu'a 2 images de décalage, vous devrez donc ajuster le timecode de votre
logiciel de montage pour garantir une précision a l'image pres.

Convert Analog Outputs : Cochez cette case pour effectuer vos conversions sur les sorties vidéo analogiques.

Display As: Sélectionnez la facon dont vous aimeriez afficher la vidéo convertie. En fonction du format de
I'image originale de la sortie vidéo, I'affichage peut étre aux formats letterbox, anamorphique, center cut,
pillarbox, zoom 16:9 ou 14:9.

Le tableau suivant explique les différents formats d'images qui peuvent étre sélectionnés pendant la conversion.
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Down Conversion Image Source Image convertie

Letterbox Affiche l'intégralité de l'image HD 16:9
sur un écran SD 4:3 avec des bandes
noires horizontales situées en haut et

en bas de l'image.

Anamorphic Comprime horizontalement l'image

HD 16:9 pour qu'elle remplisse I'écran
SD 4:3.

Center Cut L'image HD 16:9 est affichée dans un
écran SD 4:3. Ce format d'image fait
disparaitre les parties latérales de

I'image 16:9.

Pantalla normal Place l'image SD 4:3 au centre du
cadre HD 16:9. Des bandes noires

apparaissent sur les parties latérales.

_ I

Zoom (16:9) L'image 4:3 est agrandit de maniére
a remplir toute la surface de I'écran

HD 16:9.

Zoom (14:9) Compromis entre le pillarbox et le
zoom 16:9. De minces bandes noires
apparaissant en haut et en bas du

cadre.
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La page A propos fournit des informations importantes, telles
que la version du pilote, le guide d'utilisateur et les informations
de mise a jour. Vous pouvez également générer un rapport
d'état ety saisir les informations relatives a votre produit.

A propos

Pilote

La page A propos du logiciel Desktop Vidéo Utility fournit des informations concernant les pilotes actuels
de votre matériel, et la date de la derniére mise a jour.

Vous pouvez également générer un rapport d'état en cliquant sur le bouton Create. Cela permet de sauvegarder
un fichier contenant les informations techniques, telles que les formats vidéo détectés sur 'entrée et la sortie,
les espaces colorimétriques, I'échantillonnage couleur et la profondeur de bits mais aussi les informations
concernant le pilote, le systéeme d'exploitation et les informations relatives a l'appareil. Ce rapport peut
également étre utile lorsque vous contactez I'équipe du support technique Blackmagic Design. Ce fichier
est trés léger, il peut donc facilement étre envoyé par email.

Informations sur le produit

Vous pouvez choisir n'importe quel nom pour votre matériel Blackmagic Design, il est donc aisé d'utiliser
plusieurs appareils tout en sachant exactement ou ils se trouvent et comment ils sont utilisés. Ceci est
particulierement utile si vous utilisez le méme appareil a plusieurs endroits de l'installation. De plus, il peut
&tre utile de nommer les différentes unités en fonction de leur utilisation, par exemple, Suite de montage 2,
Suite d'étalonnage 1, etc.

Sivous saisissez le nom de votre matériel dans le champ de saisi Label, il sera sauvegardé sur la page d'accueil
de Blackmagic Desktop Video Utility et sera alors affiché sous I'image de l'appareil.

Vous pouvez également saisir des informations importantes que vous pourrez consulter ultérieurement, par
exemple, le numéro de série du matériel, le lieu et la date d'achat, ainsi que les coordonnées du vendeur.
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DaVinci Resolve

Etape 3. Sélectionnez le format désiré & partir du menu
« Video capture and playback ».

Etalonnage en direct avec DaVinci Resolve

Desktop Video 10 offre une capture et une lecture simultanées sur les appareils 4K de Blackmagic Design.
C'est une solution idéale pour les utilisateurs qui souhaitent bénéficier de la fonctionnalité d'étalonnage en
direct disponible sur DaVinci Resolve. lls n'ont ainsi plus besoin d'utiliser deux appareils distincts pour I'entrée
et la sortie de signaux.

Lorsque vous faites de |'étalonnage en direct sur le plateau, il vous suffit de connecter la sortie de la caméra
a l'entrée de votre matériel Blackmagic Design. Connectez ensuite la sortie de 'appareil a un moniteur de
plateau pour vérifier |'étalonnage.

Configuration

Etape 1.

Etape 2.
Etape 3.

Etape 4.
Etape 5.

Lancez le logiciel Resolve. A partir du menu Preferences, sélectionnez I'onglet « Video I/O and
GPU » puis choisissez votre matériel a partir de I'option « For Resolve Live use ». Sauvegardez vos
préférences et redémarrez Resolve pour faire appliquer vos changements.

Commencez un projet et a partir de la fenétre Project Settings, configurez la résolution et la
fréquence d'image correspondant a votre caméra.

Dans la fenétre Project Settings, allez sur I'onglet « Capture and Playback » et sélectionnez le
format désiré a partir du menu « Video capture and playback ».

Allez sur la page Edit et sélectionnez File>New Timeline.

A partir de la page Color, sélectionnez Color>Resolve Live. Vous devriez a présent voir la vidéo en
direct dans la fenétre et un bouton rouge lumineux « Resolve Live » apparait au-dessus de la vidéo.

Utiliser Resolve Live

Etape 1.

Etape 2.

En mode Resolve Live, le bouton avec I'icéne représentant un flocon fige I'image vidéo actuelle.
Vous pouvez ainsi I'étalonner sans étre distrait par le mouvement qui a lieu pendant le tournage.
Lorsque vous avez effectué votre ajustement, vous pouvez recommencer la lecture et vous préparer
a prendre un instantané.

Une fois que vous étes satisfait de votre correction, vous pouvez sauvegarder un instantané de
I'image fixe actuellement affichée dans le Viewer, la valeur du timecode entrant ainsi que votre
correction dans la Timeline en cliquant sur le bouton représentant une caméra. Les instantanés
sont tout simplement des clips qui ne comportent qu'une seule image.

Veuillez vous référer au manuel DaVinci Resolve pour obtenir de plus amples informations sur Resolve Live.
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Utilisez la fenétre Project settings pour régler les options de
formats de la timeline et de monitoring vidéo.

Montage avec DaVinci Resolve

Linterface de DaVinci Resolve est facile a utiliser et posséde tous les outils nécessaires pour monter et
peaufiner vos projets | Que vous utilisiez une souris pour déplacer et faire glisser les clips ou un clavier pour
effectuer un montage de précision, DaVinci Resolve est facile a utiliser et dispose de toutes les fonctionnalités
nécessaires aux monteurs professionnels.

Configuration

Etape 1.

Etape 2.
Etape 3.

Etape 4.

Montage

Etape 1.
Etape 2.

Etape 3.
Etape 4.
Etape 5.

Ouvrez DaVinci Resolve. Dans le menu Preferences, sélectionnez I'onglet Video I/O and GPU puis
sélectionnez 'option For Resolve Live use sur votre appareil Blackmagic Design. Sauvegardez vos
préférences et redémarrez DaVinci Resolve pour appliquer les modifications.

Chargez un projet. Dans la fenétre Projet settings, saisissez la résolution, le format d'image de la
timeline et la fréquence d'images de lecture.

Sous la section Video monitoring, saisissez le format vidéo. Il s'agit du format de sortie utilisé par
I'appareil Blackmagic Design.

Cliquez sur le bouton Save pour sauvegarder les modifications et fermer la fenétre des parameétres
du projet.

Utilisez le navigateur de la page Media pour charger des clips dans la bibliotheque de média.

Dans la page Edit, sélectionnez File>New timeline, renommez la timeline et cliquez sur le bouton
Create new timeline.

Dans la page Edit, faites glisser un clip de la bibliothéque de média vers la fenétre source.
Vous pouvez choisir les points d'entrée et de sortie des clips sources en utilisant les touches | et O.

Pour monter un clip au sein de la timeline, déplacez simplement les clips de la fenétre source vers
la timeline.

Veuillez consulter le manuel DaVinci Resolve pour davantage d'informations sur la fagon d'effectuer un
montage avec DaVinci Resolve.
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After Effects CC (2015).

'Video preview' preferences.

Choisissez une option pour acheminer les formats non pris en
charge.

Adobe After Effects CC

Comment prévisualiser de la vidéo

Pour afficher votre composition en temps réel sur votre matériel Blackmagic Design, allez sur Préférences
> Prévisualisation vidéo. La fonction Mercury Transmit doit étre activée afin de pouvoir utiliser du matériel
Blackmagic Design avec After Effects CC. Sous Périphérique vidéo, sélectionnez Blackmagic Playback. Vous
pouvez a présent utiliser un moniteur broadcast pour visualiser vos compositions After Effects dans I'espace
colorimétrique vidéo souhaité.

Sivous travaillez avec un format d'image qui n'est pas pris en charge ou qui n'est pas standard, ce format pourra
étre correctement acheminé par votre appareil Blackmagic Design. Allez sur Préférences > Prévisualisation
vidéo et cliquez sur le bouton Configuration situé a cété de Blackmagic Playback. La fenétre Blackmagic device
selection s'ouvre. Vous pouvez agrandir ou réduire |'image au format vidéo le plus proche pris en charge par
I'appareil. Par exemple, si vous utilisez I'UltraStudio 4K et la résolution de votre composition After Effects est
de 2048 x 1152, réduire sa taille I'acheminera en DCI 2K et agrandir sa taille I'acheminera en Ultra HD.

Rendu

Lorsque votre composition est terminée, vous pouvez faire un rendu avec une séquence d'image DPX ou un
des codecs suivants :

Codecs QuickTime sur Mac OS X

= Blackmagic RGB 10 bit (hon compressé) = Apple Photo - JPEG (compressé)
* Apple Uncompressed YUV 10 bit 4:2:2 * Apple DV - NTSC (compressé)
* Apple Uncompressed YUV 8 bit 4:2:2 * Apple DV - PAL (compressé)

Les autres codecs, notamment ProRes et DVCPRO HD sont disponibles si Final Cut Pro est installé sur votre
ordinateur.

Codecs AVI sur Windows
= Blackmagic 10 bit 4:4:4 (non compressé) * Blackmagic SD 8 bit 4:2:2 (non compressé)
* Blackmagic 10 bit 4:2:2 (non compressé) = Blackmagic 8 bit MJPEG (compressé)
* Blackmagic HD 8 bit 4:2:2 (non compressé)

Les autres codecs, notamment DVCPRO HD et DVCPRO50 sont disponibles si Premiere Pro CC est installé.

Codecs QuickTime sur Windows
= Blackmagic RGB 10 bit (hon compressé) = Apple Photo - JPEG (compressé)
= Blackmagic 10 bit (hon compressé) * Apple DV - NTSC (compressé)
* Blackmagic 8 bit (non compressé) * Apple DV - PAL (compressé)
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Photoshop CC (2015).

Importer une image

Exporter une image

Adobe Photoshop CC

Comment importer et exporter des images vidéo

Importer une image dans Photoshop CC
Etape 1. Sélectionnez Fichier> Importer> Blackmagic image import

Etape 2. Sélectionnez le format de I'entrée vidéo et la profondeur de bits de I'image puis cliquez sur
Importer I'image.

Exporter une image de Photoshop® CC
Etape 1. Sélectionnez Fichier > Exporter > Exporter une image Blackmagic.

Etape 2. Sélectionnez le format de la sortie vidéo puis cliquez sur Exporter I'image.

Une fois que les options d'importation et d'exportation ont été configurées, la fenétre de parametres ne
s'affichera plus lors d'importations et d'exportations ultérieures. Toutefois, vous pouvez toujours changer
vos parametres en maintenant enfoncée la touche Option (Mac) ou Ctrl (Windows) lors de la sélection
d'importations ou d'exportations.
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Premiere Pro CC (2015).

Nouvelle séquence

Choisissez une option pour acheminer les formats non pris
en charge.

Adobe Premiere Pro CC

Créer un projet Blackmagic Design

Etape 1. Créez un nouveau projet et choisissez I'emplacement et le nom désirés pour votre projet.

Etape 2. Cliquez sur l'onglet Scratch Disks (Disques de travail) pour configurer I'emplacement de votre
vidéo capturée, audio capturée, prévisualisations vidéo et prévisualisations audio.

Etape 3. Sivotre carte graphique est compatible avec le moteur Mercury Playback Engine de Premiere Pro
CC, l'option de rendu sera disponible et il vous faudra sélectionner I'option « Mercury Playback
Engine GPU Acceleration » (Accélération GPU Mercury Playback Engine).

Etape 4. Configurez le format d'acquisition sur acquisition Blackmagic et cliquez sur Paramétres (Mac) ou
Propriétés (Windows) pour configurer le standard vidéo et le format vidéo. Cliquez sur OK pour
ouvrir votre projet.

Etape 5. Pour créer une nouvelle séquence, cliquez sur Fichier > Nouveau > Séquence. Sélectionnez la
préconfiguration Blackmagic désirée, donnez un nom a la séquence et cliquez sur OK.

Controle de périphérique

De nombreux modéles de matériel d'acquisition et de lecture Blackmagic Design comprennent un contréle
de périphérique RS-422 pour le contréle des magnétoscopes. Cliquez sur Préférences > Pilotage de matériel
(Device Control) et vérifiez que le pilotage de matériel Blackmagic a été sélectionné a partir du menu
Matériel (Devices).

Lecture

Pour garantir une lecture de la vidéo et de I'audio par le matériel Blackmagic Design, vérifiez les paramétres
de lecture en allant sur Préférences > Lecture. Sélectionnez Blackmagic Playback dans les menus Périphérique
Audio et Périphérique Vidéo.

Si vous travaillez avec un format d'image qui n'est pas pris en charge ou qui n'est pas standard, ce format
pourra étre correctement acheminé depuis votre appareil Blackmagic Design. Allez sur Preferences > lecture
et cliquez sur le bouton Configuration situé a c6té de Blackmagic Playback. La fenétre Blackmagic device
selection s'ouvre. Vous pouvez agrandir ou réduire I'image au format vidéo le plus proche pris en charge par
I'appareil. Par exemple, si vous utilisez UltraStudio 4K et la résolution de votre composition Premiere est de
2048 x 1152, réduire sa taille acheminera en Ultra HD et I'agrandir I'acheminera en DCI 4K.
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Exportation sur bande
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Acquisition
Pour capturer allez sous : Fichier > Acquisition [F5]

Pour une acquisition immédiate, ou une acquisition a partir de matériel non pilotable, cliquez sur le bouton
d'enregistrement rouge [G].

Sivous souhaitez enregistrer le clip a I'aide du contréle de périphérique RS-422, saisissez les points d'entrée et
de sortie désirés a I'aide des boutons dédiés ou manuellement en saisissant le code temporel et en cliquant
sur la touche Enregistrer I'élément (Log Clip). Le clip vide apparaitra dans la fenétre Projet. Répétez l'action
jusqu'a ce que vous ayez enregistré tous les clips que vous souhaitez capturer en série. Puis choisissez : Fichier
> Acquisition en série [Fé]. Pour configurer des marges sur les clips, activez 'option d'acquisition avec marges
et saisissez le nombre d'images supplémentaires requises au début et a la fin de chaque clip.

Exportation sur bande

Si vous souhaitez exporter votre montage sur un enregistreur externe, vous pouvez le faire a l'aide de la
fonction d'exportation sur bande de Premiere. Faites votre choix entre deux types d'exportation : insertion
ou assemblage. Le montage par insertion nécessite un timecode continu sur toute la longueur du projet qui
va étre enregistré sur bande. En mode assemblage, la bande ne doit étre noire que jusqu'a un point situé
juste apres le début du projet. Comme le montage par assemblage efface la bande située avant les tétes
d'enregistrement, il ne devrait pas étre utilisé lorsque d'autres projets existent déja sur la bande aprés le
point de sortie de votre montage.

Pour une exportation sur bande via le contréle série RS-422 :

Etape 1. Sur le systéme audio de votre ordinateur, vérifiez que votre appareil Blackmagic Desktop Video
n'est pas réglé par défaut en tant qu'appareil audio.

Sur Mac, allez sur les préférences systéme et sélectionnez micro interne en tant qu'entrée et haut-
parleurs internes en tant que sortie.

Sur Windows, allez sur la barre des taches et cliquez droit sur I'icdne haut-parleur pour ouvrir les
parametres relatifs au son. Cliquez sur l'onglet lecture et réglez votre PC pour qu'il utilise le matériel
audio intégré ou un autre appareil de sortie audio que le matériel Blackmagic Design. Cliquez sur
I'onglet enregistrement et réglez votre PC pour qu'il utilise un autre appareil d'enregistrement
que celui de Blackmagic Design.

Etape 2. Allez sur les préférences de Adobe Premiere et sélectionnez matériel audio. Sélectionnez sortie
intégrée (built-in output) sous le parameétre « Son du Bureau Adobe » a l'aide du menu déroulant.
Réglez le paramétre « Mapper la sortie pour » sur « Son du Bureau Adobe » et sélectionnez
Blackmagic Playback en tant que lecteur audio. Vérifiez également que la fonction de lecture
Blackmagic a été sélectionnée pour le périphérique vidéo.
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Etape 3. Ouvrezlafenétre de montage surbande de Premiere en cliquant sur Fichier > Exportation > Exporter
sur bande (matériel série). Cliquez ensuite sur les paramétres du périphérique d'enregistrement et
sélectionnez Acquisition Blackmagic > Paramétres > Format et choisissez le format d'acquisition
souhaité. Si le format d'acquisition ne correspond pas au format de sortie, cela peut provoquer
des problémes durant le preroll, ce qui peut empécher I'exportation de l'audio.

Etape 4. Réglez a présent le type d'exportation en choisissant entre le mode assemblage ou insertion.
Saisissez le point d'entrée désiré et cliquez sur OK (Mac) ou Exporter (Windows).

Lors du montage sur bande, le logiciel attend a la premiére image de votre projet que le magnétoscope
commence |'enregistrement en fonction d’'un timecode prédéterminé. Au cas ou la premiére image de votre
programme aurait été répétée ou perdue durant la procédure de montage sur bande, il faudra ajuster le
paramétre relatif au décalage de lecture du périphérique vidéo pour synchroniser 'enregistreur et I'ordinateur.
Vous n'aurez a le faire gu'une seule fois indépendamment de I'enregistreur et de |'ordinateur car ce paramétre
sera gardé en mémoire.

Vos paramétres son ne doivent étre modifiés que pour la fonction Exportation sur bande. N'oubliez pas de
retourner dans les paramétres son de votre ordinateur et de les restaurer pour ne pas affecter votre workflow.
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Final Cut Pro X.

Etape 2. Configurez la norme vidéo par défaut qui correspond
a votre projet Final Cut Pro X dans les préférences systéme.

Etape 6. Sous le paramétre Propriétés audio et de rendu,
choisissez l'option Personnalisées.

Final Cut Pro X

Vous pouvez utiliser la fonctionnalité de monitoring broadcast de Final Cut Pro X 10.0.4 et acheminer
ultérieurement votre vidéo a du matériel vidéo Blackmagic Design. Vous pouvez également utiliser deux
écrans d'ordinateur pour l'interface de Final Cut Pro X.

Configurer Final Cut Pro X

Etape 1.

Etape 2.

Etape 3.
Etape 4.
Etape 5.

Etape 6.

Etape 7.

Etape 8.

Vérifiez que vous étes en possession de la version Final Cut Pro X 10.0.4 ou plus récente ainsi que
de la derniére version de Mac OS X Mavericks ou Yosemite.

Ouvrez 'utilitaire Blackmagic Desktop Video. Allez sur le parameétre Format de sortie et choisissez
le méme format que celui de votre projet Final Cut Pro X, par ex., HD 1080p29.97. Le format doit
étre identique a celui du format vidéo de vos clips.

Ouvrez Final Cut Pro X et créez un nouveau projet.
Saisissez un nom et choisissez un emplacement pour le nouveau projet.

Sous le paramétre Propriétés vidéo, choisissez l'option Personnalisées et configurez ensuite le
format, la résolution et la fréquence d'images correspondant au format de sortie réglé sur I'utilitaire
Blackmagic Desktop Video Utility.

Sous le parametre Propriétés audio et de rendu, choisissez |'option Personnalisées. Configurez
les canaux audio sur Stéréo. Vous pouvez également choisir l'option Surround pour é canaux
audio. Configurez la fréquence d'échantillonnage audio sur 48kHz. Sous le paramétre Format
du rendu, choisissez le méme format que vos clips vidéo. Par défaut, Final Cut Pro X utilise de la
compression ProRes mais vous pouvez modifier cela en sélectionnant le format 4:2:2 10 bits non
compressé pour un workflow non compressé. Cliquez sur OK pour terminer la création de votre
nouveau projet.

Allez sur le menu Final Cut Pro, choisissez Préférences et cliquez ensuite sur l'onglet Lecture.
Vérifiez que le menu Sortie A/V affiche Blackmagic et que le standard vidéo est identique a celui
de votre projet. Fermez les Préférences.

Allez dans le menu Fenétre (Window) et sélectionnez 'option Sortie A/V pour activer la sortie
vidéo via le matériel vidéo Blackmagic Design.

Si vous souhaitez faire du monitoring audio via le matériel vidéo Blackmagic Design, ouvrez les préférences

systéme, cliquez sur l'icéne son, puis cliquez sur I'onglet Sortie et sélectionnez l'audio Blackmagic en tant
que sortie audio.
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Etape 3. Cliquez sur Réglages (Settings) et sélectionnez le
codec vidéo désiré a partir du menu déroulant.

Lecture

Etape 1. Importez des clips dans votre nouveau projet.

Etape 2. Vouspouvez a présent utiliser la timeline Final Cut Pro X sur votre écran d'ordinateur et visualiser la
prévisualisation de la vidéo sur I'écran ou sur une télévision connectée a la sortie de votre matériel
vidéo Blackmagic Design.

Capturer de la vidéo et de l'audio

Vous pouvez utiliser le logiciel Blackmagic Media Express pour capturer de la vidéo et de 'audio a l'aide de
votre matériel vidéo Blackmagic Design. Une fois les clips capturés, vous pouvez les importer dans Final Cut
Pro X pour le montage.

Lorsque vous capturez des clips avec Media Express, il vous faudra choisir un des formats vidéo compatibles
avec Final Cut Pro X, par ex. : Apple ProRes 4444, Apple ProRes 422 (HQ), Apple ProRes 422 ou 4:2:2 10 bits
non compressé.

Montage sur bande

Une fois que vous avez terminé votre projet dans Final Cut Pro X, vous pouvez faire un rendu du projet
puis utiliser Blackmagic Media Express pour faire un master sur bande a l'aide de votre matériel vidéo
Blackmagic Design.

Etape 1. Sélectionnez vos clips a partir de la timeline de Final Cut Pro X.
Etape 2. Allez sur Fichier>Partager>Fichier master et la fenétre Fichier master s'ouvrira.
Etape 3. Cliquez sur Réglages (Settings) et sélectionnez le codec vidéo désiré a partir du menu déroulant.

Etape 4. Cliquezsur « Suivant... » (Next..) pour sélectionner un emplacement pour votre média, puis cliquez
sur « Enregistrer » (Save).

Etape 5. Ouvrez Media Express et importez le clip qui a été exporté de Final Cut Pro X.

Etape 6. Veuillez vous référez a la section Blackmagic Media Express de ce manuel pour obtenir des
informations sur le montage des fichiers vidéo et audio sur bande.
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Avid Media Composer.

Sivous utilisez un seul écran d'ordinateur, ouvrez le
Blackmagic Desktop Video Utility et choisissez d'envoyer du
noir lorsqu'il n'y pas de vidéo en lecture.

Etape 5. Saisissez un nom de projet et configurez les options
du projet.

Avid Media Composer

Le logiciel Avid Media Composer capture et lit de l'audio et de la vidéo en définition standard et en haute
définition avec le matériel vidéo Blackmagic Design. Ce dernier prend également en charge le contréle de
périphérique RS-422. Les plug-ins Blackmagic pour Media Composer sont automatiquement installés si Media
Composer a été installé avant le logiciel Desktop Video.

Configuration

Etape 1. Lancezle logiciel Media Composer et la boite de dialogue vous permettant la sélection de votre
projet va apparaitre.

Etape 2. Choisissez le profil d'utilisateur désiré si vous en aviez déja créé un auparavant.

Etape 3. Sélectionnezle dossier dans lequel vous souhaitez créer le projet : Private (privé), Shared (partagé)
ou External (externe).

Etape 4. Cliquez sur le bouton New Project (nouveau projet).

Etape 5. Saisissez un nom de projet et configurez les options du projet y compris le format, I'espace
colorimétrique et la 3D stéréoscopique. Cliquez sur OK. Les paramétres Color space et Stereoscopic
peuvent étre changés ultérieurement dans I'onglet Format du projet.

Etape 6. Double-cliquez sur le nom du projet dans la boite de dialogue Select Project. Linterface Media
Composer apparaitra avec la fenétre de projet pour votre nouveau projet. La configuration de
votre projet est a présent terminée.

Lecture

Afin de vérifier que tout est connecté correctement, reportez-vous a la section du Guide de montage de
Media Composer intitulée « Importation de barres de couleurs et autres mires de test ». Double-cliquez sur
le fichier importé pour le lire dans une nouvelle fenétre. Vous devriez a présent voir I'image sur votre écran
d'ordinateur ainsi que sur la sortie de votre matériel Blackmagic Design.

Si vous ne voyez pas de vidéo sur la sortie de votre matériel Blackmagic Design, revérifiez les connexions et
les paramétres de sortie dans les préférences systeme de Blackmagic Design. Pour ce faire, allez sur Tools >
Hardware Setup au sein du logiciel Media Composer.
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Capturer a partir de matériel non pilotable

De nombreuses sources vidéo, y compris différentes sortes de caméras modernes et d'enregistreurs a
disque, ainsi que des caméras plus anciennes et des magnétoscopes VHS, ne possédent pas de contrdle de
O périphérique. Pour capturer de la vidéo sans contrdle de périphérique, suivez les étapes ci-apres :

Etape 1. Pour ouvrir la fenétre Capture Tool (outil de capture), allez sur Tools > Capture.

Etape 2. Cliquez sur le bouton permettant la commutation de la source pour qu'un cercle barré rouge
s'affiche sur le bouton icéne du magnétoscope. Ce symbole indique que le contréle de
périphérique a été désactivé.

Etape 3. Configurez les menus d'entrée Video et Audio sur Blackmagic.

Etape 4. Sélectionnez la piste vidéo (V) et les pistes audio (A1, A2, ..) que vous souhaitez capturer.

Etape 5. Utilisezle menu Bin (chutier) pour sélectionner un chutier cible & partir de la liste des chutiers ouverts.

Etape 6. A partir du menu Res (résolution), choisissez le codec compressé ou non compressé que vous
souhaitez utiliser pour vos clips capturés. Pour de la vidéo 8 bits non compressée, sélectionnez «
11 » et « 1:1 10b » pour du 10 bits.

Etape 7. Sélectionnez le disque de stockage pour votre vidéo et votre audio capturés. Utilisez le bouton
Single/Dual Drive Mode pour choisir si la vidéo et 'audio seront stockés ensemble sur le méme
disque ou sur des disques séparés. Sélectionnez ensuite le ou les disque(s) cible pour votre média
capturé a partir du menu Target Drive.

Etape 8. Cliquez sur le bouton « Tape Name? » situé au bas de la fenétre pour ouvrir la boite de dialogue
qui permet la sélection de labande. Sélectionnez labande désirée, ou ajoutez une nouvelle bande,
puis cliquez sur OK.

Etape 9. Vérifiez que votre vidéo et source audio sont prétes ou en lecture, puis cliquez sur le bouton de
capture. Le bouton de capture rouge clignotera pendant I'enregistrement. Pour arréter la capture,
cliquez a nouveau sur le méme bouton.

Etape 2. Configurez les paramétres de la fenétre Capture Tool
pour capturer de la vidéo sans contrdle de périphérique en
cliquant sur le bouton permettant de commuter la source.
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( )

Etape 6. Dans la fenétre relative aux préférences du
magnétoscope, activez la fonction « Relax coincidence
point detection ».

-

Configurez le bouton CAP et le bouton permettant
la commutation de la source pour utiliser le controle
de magnétoscope. Utilisez la section de contréle du
magnétoscope pour positionner la bande et
commencer la lecture.

Capturer a partir de matériel pilotable avec UltraStudio, DeckLink et Teranex

Si vous possédez un magnétoscope qui se connecte via RS-422, il vous faudra configurer les paramétres du
magnétoscope avant d'effectuer une capture avec le contréle de périphérique.

Etape 1.

Etape 2.

Etape 3.

Etape 4.
Etape 5.

Etape 6.

A partir de la fenétre de votre projet, cliquez sur l'onglet Settings (paramétres) et double-cliquez sur
Deck Configuration (configuration du magnétoscope).

Dans la boite de dialogue Deck Configuration, cliquez sur I'option Add Channel (ajouter un canal) puis
configurez le paramétre Channel Type (type de canal) sur Direct et le paramétre Port sur RS-422 Deck Control
(controle de périphérique RS-422). Cliquez sur OK et sélectionnez « No » lorsqu'on vous demandera si
vous souhaitez une configuration automatique du canal (Do you want to autoconfigure the channel now?).
Cliquez sur Add Deck (ajouter un magnétoscope) et sélectionnez ensuite la marque et le modéle de
magnétoscope a partir du menu listant les appareils. Configurez également le paramétre Preroll (temps
de démarrage). Cliquez sur OK et puis sur Apply (@ppliquer).

Sous l'onglet Settings, double-cliquez sur Deck Preferences (préférences du magnétoscope).

Si vous allez faire du montage sur bande par assemblage, activez la fonction « Allow assemble edit &
crash record for digital cut ». Si vous ne sélectionnez pas cette option, vous ne pourrez qu'effectuer du
montage par insertion.

Activez lafonction « Relax coincidence point detection » et configurez les autres parameétres si nécessaire.
Cliquez sur OK. La configuration de la connexion RS-422 a votre magnétoscope est a présent terminée.

Pour tester la connexion a distance, assurez-vous qu'un cable série RS-422 est connecté entre votre matériel vidéo

Blackmagic Design et I'enregistreur. Configurez I'enregistreur sur Remote. Ouvrez la fenétre Capture Tool et utilisez

les raccourcis clavier standard J, K, L pour contréler I'enregistreur. Si le nom d'un enregistreur apparait en italique

ou que le message « No Deck » est affiché, cliquez sur le menu et sélectionnez l'option « Check Decks » (vérifier les

enregistreurs) jusqu'a ce que l'enregistreur ne soit plus listé en italique et que le contréle de périphérique soit rétabli.

Pour capturer de la vidéo a la volée avec controle de périphérique :

Etape 1.
Etape 2.

Etape 3.

Etape 4.

Etape 5.

Etape 6.

Pour ouvrir la fenétre Capture Tool (outil de capture), allez sur Tools > Capture.

Le bouton de mode Capture/Log devrait afficher I'icéne CAP. Si ce bouton affiche I'icéne LOG, cliquez
sur ce dernier pour le mettre en mode capture; I'icéne CAP devrait alors apparaitre.

Le bouton permettant la commutation de la source devrait afficher I'icbne magnétoscope. Sivous voyez
un cercle rouge barré, cliquez sur le bouton pour activer le contréle de périphérique et faire disparaitre
le symbole rouge.

Configurez les entrées vidéo et audio, les pistes des sources vidéo et audio, le chutier cible, la résolution,
le disque cible et le nom de la bande comme décrit précédemment dans la section « Capturer a partir
de matériel non pilotable ».

Utilisez la section de contréle du magnétoscope située dans la fenétre Capture Tool pour positionner
la bande et commencer la lecture.

Cliquez sur le bouton de capture. Le bouton de capture rouge clignotera pendant l'enregistrement.
Pour arréter la capture, cliquez a nouveau sur le méme bouton.
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O

Etape 5. Cliquez sur le bouton représentant les points
d'entrée et de sortie ou utilisez les touches «i» et « 0 » de
votre clavier pour marquer les points d'entrée et de sortie.

L'outil Digital Cut est utilisé pour I'enregistrement sur bande.

Capturer en série avec UltraStudio et DeckLink

Pour enregistrer des clips pour I'acquisition en série :

Etape 1.
Etape 2.
Etape 3.

Etape 4.

Etape 5.

Etape 6.

Etape 7.

Pour ouvrir la fenétre Capture Tool (outil de capture), allez sur Tools > Capture.
Cliguez sur le bouton permettant la sélection du mode Capture/Log afin que ce dernier affiche I'icéne LOG.

Configurez les entrées vidéo et audio, les pistes des sources vidéo et audio, le chutier cible, la résolution,
le disque cible et le nom de la bande comme décrit précédemment dans la section « Capturer a partir
de matériel non pilotable ».

Utilisez la section de contréle du magnétoscope ou les raccourcis clavier standardj, k, | pour faire une avance
ou un retour rapide de la vidéo, mettre la vidéo en pause et repérer la vidéo que vous souhaitez capturer.

Cliquez sur le bouton permettant de marquer les points d'entrée et de sortie; ce dernier est situé a
gauche du bouton LOG. L'icdne va alterner entre point d'entrée et point de sortie, ce qui vous permet
de marquer tous vos points d'entrée et de sortie avec le méme bouton. Cette option peut s'avérer plus
pratique que d'utiliser les boutons de point d'entrée et de sortie indépendants situés dans la section
de contréle du magnétoscope. Vous pouvez également utiliser les touches « i » et « o » de votre clavier
pour marquer les points d'entrée et de sortie.

Lorsque vous avez terminé d'enregistrer les points d'entrée et de sortie, ouvrez le chutier d'enregistrement
et sélectionnez les clips que vous souhaitez capturer.

Sélectionnez Clip > Batch Capture (acquisition en série), puis sélectionnez les options désirées dans la
boite de dialogue et cliquez sur OK.

Enregistrer sur bande avec UltraStudio et DeckLink

Une fois que vous avez capturé vos clips, que vous les avez déposés dans la timeline, édités et appliqué vos effets,
vous pourrez enregistrer le projet terminé sur bande.

Etape 1.
Etape 2.
Etape 3.

Etape 4.

Etape 5.

Etape 6.

Double-cliquez sur une séquence dans le chutier de votre projet pour I'ouvrir dans la fenétre timeline.
Sélectionnez Output > Digital Cut pour ouvrir I'outil Digital Cut.

Configurez le paramétre Output Mode (mode de sortie) sur Real-Time (temps réel), le paramétre Bit Depth
(profondeur de bits) sur 10-bits et le parameétre Deck Control (contrdle de magnétoscope) sur Remote (a
distance).

A partir du menu Edit, choisissez la fonction Insert Edit (montage par insertion) ou Assemble Edit (montage
par assemblage) pour un montage précis sur une bande pistée. Vous pouvez également sélectionner la
fonction Crash Record qui vous offre un moyen tres facile d'enregistrer. Si seule I'option Insert Edit est
disponible, allez sur l'onglet Settings (parametres) de votre projet, double-cliquez sur Deck Preferences
(préférences du magnétoscope) et activez la fonction « Allow assemble edit & crash record for digital cut ».
Si le nom d'un magnétoscope apparait en italique ou que le message « NO DECK » est affiché, cliquez
sur le menu et sélectionnez I'option « Check Decks » (vérifier les magnétoscopes) jusqu'a ce que le
magnétoscope ne soit plus listé en italique et que le contrdle de périphérique soit rétabli.

Appuyez sur le bouton de lecture de I'outil Digital Cut (triangle rouge) pour enregistrer votre séquence
sur bande.
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Autodesk Smoke

Saisissez un nom de projet et configurez les options du projet.

Autodesk Smoke Extension 1

Le logiciel Autodesk Smoke réunit le montage, le compositing et les effets 3D dans un seul espace de travail.
Smoke capture et lit de l'audio et de la vidéo en définition standard et en haute définition avec le matériel
vidéo Blackmagic Design. Ce dernier prend également en charge le contréle de périphérique RS-422. Avant
d'installer le logiciel Autodesk Smoke, assurez-vous que les pilotes Blackmagic Design et votre matériel vidéo
sont correctement installés.

Le monitoring broadcast de Smoke vous permet d'acheminer de la vidéo via le matériel Blackmagic Design.

Installation

Etape 1. Lancez Smoke et la fenétre relative aux paramétres du projet et de I'utilisateur apparaitra.
Sélectionnez votre projet et |'utilisateur si vous les aviez créés auparavant. Le cas échéant, créez
un nouveau projet et/ou utilisateur.

Etape 2. Configurez les paramétres du projet pour les faire correspondre aux paramétres de rendu,
par ex., T080HD. La plupart de ces paramétres peuvent étre modifiés ultérieurement pendant
votre session.

Etape 3. Choisissez votre format intermédiaire, tel que ProRes 422 ou méme non compressé pour les
médias générés par votre projet. N'oubliez pas de choisir un format que votre disque puisse
prendre en charge.

Etape 4. Cliquez sur le bouton Create.

Installation du matériel
Il est judicieux de suivre les étapes suivantes lorsque vous vous préparez pour une session VTR.
Etape 1. Connectez les sorties de votre VTR aux entrées de votre appareil d'acquisition et de lecture

Blackmagic Design. Connectez les sorties de votre appareil d'acquisition et de lecture Blackmagic
Design aux entrées de votre VTR.

Etape 2. Connectez un cable de contrdle de périphérique RS-422 a partir du port série de votre magnétoscope
au port de contrdle a distance de votre matériel d'acquisition et de lecture Blackmagic Design.

Etape 3. Configurez votre magnétoscope sur Remote.

Etape 4. Connectez un générateur de synchro a I'entrée de la synchronisation du magnétoscope pour
garantir une capture précise a l'image prés. Si vous possédez un appareil audio séparé, il vous
faudra également lui connecter un signal de synchronisation audio.
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Assurez-vous que les paramétres Video Device et Audio
Device sont configurés sur BMD dans I'utilitaire Smoke Setup.

Sélectionnez les paramétres Timing pour votre VTR a |'aide de
l'onglet VTR dans 'utilitaire Smoke Setup.

Les pistes vidéo et audio deviennent rouges lorsqu'elles sont
activées pour une capture a partir de votre magnétoscope.

Configurer un magnétoscope

Avant de lancer Autodesk Smoke, il vous faut utiliser un utilitaire appelé Smoke Setup pour sélectionner le
modéle de magnétoscope utilisé dans votre studio ainsi que la résolution et la fréquence d'image.

Etape 1.
Etape 2.

Etape 3.

Etape 4.

Allez sur Applications>Autodesk>Smoke>Utilities et ouvrez Smoke Setup.

Sous l'onglet General, assurez-vous que les parameétres Video Device et Audio Device sont
configurés sur BMD.

Sous l'onglet VTR, sélectionnez le modéle de magnétoscope, la résolution et la fréquence d'image
(timing) que vous souhaitez utiliser avec Autodesk Smoke. Activez les lignes affichant live NTSC
ou live PAL pour permettre un enregistrement en mode direct ou une sortie en direct.

Cliquez sur Apply et fermez Smoke Setup.

Capturer a partir de matériel pilotable avec UltraStudio et DeckLink

Autodesk Smoke peut étre configuré pour capturer a partir de magnétoscopes pilotables avec le contrdle
de périphérique RS-422.

Etape 1.
Etape 2.
Etape 3.
Etape 4.

Etape 5.
Etape 6.

Etape 7.

Dans la Media Library, sélectionnez le dossier ol vous souhaitez que le clip capturé soit créé.
Sélectionnez File>Capture from VTR. Le module VTR Capture va apparaitre.
Positionnez la bande sur 'image de départ du clip que vous souhaitez capturer.

Sélectionnez les canaux vidéo et audio que vous désirez enregistrer. Les boutons deviendront
rouges pour vous indiquer les pistes activées.

Saisissez les points d'entrée et de sortie dans les champs In et Out.

Cliguez sur le bouton de capture pour commencer la capture. Le champ du timecode deviendra
vert pour vous indiquer que la capture est en cours.

Terminez la capture quand vous le souhaitez en cliquant n'importe ou sur la fenétre de prévisualisation.
Le clip sera automatiquement sauvegardé a I'emplacement que vous aviez sélectionné avant
d'entrer dans le module VTR Input.
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Etape 3. Sélectionnez votre magnétoscope dans le menu
déroulant.

[

Les clips que vous avez sélectionnés pour étre acheminés
ainsi que leur état actuel apparaissent sur une liste.

Starton T

Insert ] Stop After Frames

Preview Fram
X

Spiit

Sélectionnez vos points d'entrée et de sortie, puis
sélectionnez |'option Insert dans le menu déroulant Output.

Enregistrer sur bande avec UltraStudio et DeckLink

Téléchargez un clip dans le module VTR Output et configurez les points d'entrée et de sortie pour le clip
de sortie. Si besoin est, vous pouvez également activer les options vous permettant de décaler I'image du
début et d'appliquer le format Letterbox.

Etape 1.
Etape 2.
Etape 3.
Etape 4.
Etape 5.
Etape 6.
Etape 7.

Etape 8.
Etape 9.

Etape 10.

Etape 11.

Sélectionnez File>Output to VTR.

Choisissez le ou les clips que vous souhaitez acheminer a partir de la Media Library. Vous pouvez
également sélectionner un dossier si vous désirez acheminer son contenu dans une seule session.
Le module VTR Qutput va apparaitre.

Sélectionnez I'option VTR dans la boite de sélection Device Name. La fenétre de prévisualisation
affiche la vidéo de la bande appartenant au magnétoscope sélectionné.

Assurez-vous que les boutons de la piste vidéo et des canaux audio sont activés pour que la piste
vidéo et les canaux audio correspondants soient acheminés sur la bande.

Activez ou désactivez le parametre All Audio dans le menu Clip Output. Lorsque le paramétre
All Audio est activé, tous les canaux audio seront convertis au format de votre bande, et non pas
seulement les canaux que vous avez activés.

Cliquez sur le bouton Preview pour prévisualiser le clip avant de I'acheminer.

Pour acheminer le clip sélectionné en commencant par n'importe quelle image autre que la
premiére, saisissez le timecode de départ dans le champ Start Offset.

Configurez les points d'entrée et de sortie pour la sortie du clip.

Pour acheminer le clip au magnétoscope, sélectionnez l'option Insert dans la boite de sélection
Output. Les clips dont la colonne Status affiche « selected » seront acheminés sur la bande. Lors
de I'acheminement, I'état de chaque clip sera mis a jour, en commencant par « Pending » puis «
Output » et finalement « Done ».

Positionnez la bande sur le timecode du point d'entrée et sélectionnez Play pour vérifier que le
transfert a réussi.

Lorsque vous avez terminé, cliquez sur EXIT Output Clip pour fermer le module.
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Activez les lignes affichant live NTSC ou live PAL pour
permettre un enregistrement en mode direct ou une sortie
en direct.

Enregistrement instantané et sortie en direct

Autodesk Smoke vous permet de capturer un signal vidéo en direct ou d'enregistrer instantanément un clip
et d'utiliser une tablette a stylet ou une souris pour commencer ou arréter le processus d'entrée ou de sortie
du clip. Lorsque vous choisissez cette forme de capture, Autodesk Smoke vérifie I'espace disponible sur
votre matériel de stockage de médias Autodesk. Ce dernier peut varier selon le format intermédiaire choisi.

De plus, si vous utilisez un appareil qui ne prend pas en charge le contréle a distance via RS-422, comme par
exemple une caméra, un VCR ou tout autre appareil, utilisez I'option Live NTSC ou PAL pour la capture, et
['option Live Video pour acheminer les clips.

Pour enregistrer instantanément un signal vidéo en direct :
Etape 1. Choisissez un dossier dans la Media Library o vous souhaitez créer le clip capturé.

Etape 2. Sélectionnez File>Capture from VTR. Le module VTR Capture va apparaitre.

Etape 3. A partir de la boite de sélection VTR Device, sélectionnez Live NTSC ou Live PAL. Le signal vidéo
en direct va apparaitre dans la fenétre de prévisualisation.

Etape 4. Sélectionnez le mode Start On Pen. Arrétez la capture a I'aide des fonctions Stop On Pen ou Stop
On Frames. Traditionnellement, Autodesk Smoke fonctionnait avec une tablette et un stylet (pen),
c'est ce qui a donné le nom a ces fonctions.

Lorsque la fonction Stop On Pen est sélectionnée pour arréter la capture, les champs « Out » et « Duration »
seront mis a jour pour indiquer la longueur de clip maximale pouvant étre enregistrée sur votre matériel
de stockage de médias Autodesk. La capture s'arrétera lorsque vous cliquerez n'importe ou sur I'écran ou
lorsque votre disque sera plein.

Etape 5. Saisissezle nom du clip et activez les pistes vidéo et les canaux audio que vous souhaitez capturer.
Etape 6. Assurez-vous que vous recevez le signal vidéo en direct.

Etape 7. Appuyez sur Play sur l'appareil vidéo.

Etape 8. Sélectionnez la fonction Process pour commencer la capture.

Etape 9. Cliquez n'importe ot sur I'écran pour arréter la capture en mode Stop On Pen.
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Input Clip

Live NTSC ¢ 10 Bit Depte 'Field 1
Eng

Sélectionnez Live PAL ou Live NTSC lorsque vous acheminez
un signal vidéo en direct.

Start on Pen

Lorsque vous acheminez de la vidéo en direct, il vous faut
utiliser le mode Start On Pen.

Pour acheminer un signal vidéo en direct :
Etape 1. Sélectionnez File>Output to VTR.

Etape 2. Choisissez le ou les clips que vous souhaitez acheminer & partir de la Media Library. Vous
pouvez également sélectionner un dossier pour acheminer son contenu. Le module VTR Output
va apparaitre.

Etape 3. A partir de la boite de sélection VTR Device, sélectionnez Live NTSC ou Live PAL.

La boite de sélection Start Mode n'est pas disponible. Avec une sortie vidéo en direct, il vous faut utiliser le mode
Start On Pen. Vous pouvez utiliser les fonctions Stop On Pen ou Stop On Frames pour arréter I'acheminement.

Etape 4. Configurez les options de sortie. Par exemple, saisissez le nom du clip et activez les pistes vidéo
et les canaux audio que vous souhaitez capturer.

Etape 5. Surl'appareil quirecoit le signal, commencez I'enregistrement ou faites le nécessaire pour activer
la réception du signal provenant d'Autodesk Smoke.

Etape 6. Sélectionnez la fonction Process pour commencer a acheminer le signal sur Autodesk Smoke.

Etape 7. Cliquez n'importe ou sur I'écran pour arréter la sortie du signal en mode Stop On Pen.
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Utilisez la fenétre Preferences pour configurer le format
vidéo, le format de fichier, I'emplacement de stockage
et d'autres paramétres.

Qu'est-ce que le Media Express ?

Le logiciel Blackmagic Media Express est inclus avec les produits UltraStudio, DeckLink, Intensity, ATEM
Switcher, Blackmagic Camera, H.264 Pro Recorder, Teranex Processor et Universal Videohub. Le logiciel Media
Express 3 est un outil trés pratique lorsque vous désirez simplement capturer, lire et acheminer des clips sur
bande et que vous n'avez pas besoin de la complexité d'un logiciel de montage non-linéaire.

Capturer des fichiers vidéo et audio

Création d'un projet
Media Express détecte automatiquement le format vidéo de I'entrée et fait correspondre le format vidéo du
projet. Toutefois, si vous souhaitez régler manuellement le format vidéo du projet, suivez les étapes suivantes :

Etape 1. Allez sur Media Express>Preferences sur Mac, ou Edit>Preferences si vous utilisez Media Express
avec Windows ou Linux. Sélectionnez le format vidéo du projet a partir du menu déroulant situé
en haut de la fenétre Preferences. Faites votre sélection entre toute une gamme de formats de
capture compressés et non compressés ou méme une séquence d'image DPX a partir du menu
déroulant intitulé Capture File Format. La vidéo sera capturée au format choisi puis sauvegardée
au format QuickTime. Vous pouvez également choisir de capturer une source RVB a l'aide d'un
codec YUV et vice versa.

Etape 2. Faites votre sélection entre toute une gamme de formats de capture compressés et non compressés
ou méme une séquence d'image DPX a partir du menu déroulant intitulé Capture File Format. La
vidéo sera capturée au format choisi puis sauvegardée au format QuickTime.

Etape 3. Configurez I'emplacement de stockage pour votre vidéo et votre audio capturés.

Les projets en définition standard sont configurés au format 4:3 a moins que vous ne cochiez la case Use
Anamorphic SD 16:9 (Utiliser le format SD anamorphosé 16:9).

En général, les applications suspendent la lecture de la vidéo si vous les placez en arriére-plan. Sivous désirez
que Media Express continue la lecture de la vidéo, méme lorsque vous ouvrez une autre application en premier
plan, sélectionnez la case intitulée « Continue playback when in the background ».

Les dernieres options concernent les magnétoscopes munis du controle de périphérique RS-422 et comprennent
les fonctions relatives au preroll et au décalage de timecode.
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Timecode du
Liste de médias Affichage Liste par timecode, Vignettes et Favoris Fonction de recherche magnétoscope / périphérique Prévisualisation de la vidéo

[
[
—
[
Nom du projet, format vidéo Chutiers Points d'entrée / Prendre une Options de Commandes Vu-metres
et fréquence d'image de sortie image fixe capture de transport
Informations Canal audio Indicateur de

relatives au clip activer/désactiver contréle a distance
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Saisissez une description de votre vidéo.

Choisissez le nombre de canaux audio a capturer.

Cliquez sur le bouton « Capture » pour commencer la capture.

Media Express vous avertit lorsque le format vidéo de l'entrée
est différent de celui du projet.

Capture

Il est tres facile de capturer de la vidéo. Il vous suffit de connecter une source vidéo, de régler les préférences
de Media Express et d'appuyer sur le bouton Capture.

Etape 1. Commencez par connecter la source vidéo & une entrée de votre matériel Blackmagic Design.
Lancez le Blackmagic Desktop Video Utility et vérifiez que le paramétre « Set video input » est
identique a celui de votre source vidéo, par ex., SDI, HDMI, composante, etc.

Etape 2. Ouvrez Media Express et cliquez sur I'onglet rouge intitulé Log and Capture.

Etape 3. Votre source vidéo apparait dans la fenétre de prévisualisation. Saisissez une description dans le
champ « Description ».

Etape 4. Cliquezsurle bouton « + » situé & cété de la description pour ajouter le texte au champ automatique
« Name ». Cliquez sur le bouton « + » situé a coté de tous les autres champs que vous souhaitez
ajouter au champ Name.

= Vous pouvez augmenter la valeur dans chacun de ces champs en cliquant sur l'icone « clap »
correspondant. Vous pouvez également saisir du texte directement dans le champ désiré pour
modifier son nom ou son numéro.

* Le texte saisi dans le champ Name sera attribué au(x) clip(s) que vous vous apprétez a capturer.

= Pour enregistrer le clip en tant que favori, cliquez sur l'icéne « étoile » située a coté du
champ Name.

« Sivous souhaitez gqu'une confirmation du nom du clip apparaisse avant chaque capture,
cliquez sur l'icdne « | » située a coté du champ Name.

Etape 5. Choisissez le nombre de canaux audio & capturer.

Etape 6. Cliquez sur le bouton « Capture » pour commencer l'enregistrement. Pour arréter la capture et
conserver le clip, cliquez a nouveau sur le bouton « Capture » ou appuyez sur esc. Les clips capturés
sont ajoutés a la liste de médias sur le coté gauche de Media Express.

Lorsque le format vidéo de l'entrée est différent de celui du format vidéo du projet, Media Express le détecte
et vous demande de sauvegarder le projet en cours et d'en créer un nouveau.

Indexer des clips

Assurez-vous qu'un céable série RS-422 est connecté entre votre matériel vidéo Blackmagic Design et
I'enregistreur. Cliquez sur le bouton situé a coté du champ « In » pour marquer le point d'entrée, ou utilisez
le raccourci i.

Cliguez sur le bouton situé a cété du champ « Out » pour marquer le point de sortie, ou utilisez le raccourci o.

Cliquez surle bouton Log pour indexer le clip, ou utilisez le raccourci p. Le clip saisi devrait a présent apparaitre
dans laliste de médias et son icdne devrait comporter un Xrouge pour indiquer que le média n'est pas disponible.
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Préférences de capture DPX

Sélectionnez un format vidéo qui contient « 3D » dans son
nom pour capturer des clips vidéo en 3D stéréoscopique
double flux.

En mode d'affichage Vignettes, les clips oeil gauche et oeil
droit sont connectés par un indicateur 3D et présentés en tant
qu'une seule et grande icone.

Acquisition en série

Aprés avoir indexé un clip, vous pouvez cliquer sur le bouton Clip pour capturer un seul clip.
Pour capturer plusieurs clips, continuez a indexer les clips que vous souhaitez capturer en série.
Sélectionnez les clips indexés dans la liste de médias et effectuez |'une des actions suivantes :

* Cliquez sur le bouton Batch.
* Faites un clic-droit sur la sélection puis sélectionnez Batch Capture.
= Allez sur le menu File et choisissez Batch Capture.

Media Express capturera le clip a partir du timecode du point d'entrée au timecode du point de sortie.

Capture DPX

Si vous souhaitez capturer une séquence d'images DPX plutdt qu'un fichier .mov, ouvrez les préférences de
Media Express et configurez le format du fichier de capture (Capture File Format) sur DPX 10-Bit RGB.

* Créez un projet DPX en configurant le format du fichier de capture sur DPX.
+ Capturez.

Lorsque la capture est terminée, une seule imagette apparaitra dans la liste de médias. Cette derniére
représentera la séquence d'images entiére. La séquence d'images DPX sera stockée dans son propre dossier
sur votre disque de stockage. L'audio sera stocké dans un fichier .wav au sein du méme dossier.

Par défaut, les captures DPX sont supposées provenir de sources YUV. Sivous capturez a partir d'une source
RVB, sélectionnez I'option « Capture from a RGB source ».

Si vous désirez que les numéros d'image DPX soient basés sur le timecode de la vidéo capturée, plutdt que
de commencer par zéro, activez |'option « Use absolute frame numbering when capturing DPX ».

Si vous n'effectuez pas de longues captures DPX, il est possible de réduire le nombre de zéros des numéros
relatifs aux images en modifiant 'option « When capturing DPX files, use (2-8) digit numbers in the frame count ».

Capture 3D

Lorsque Media Express est utilisé avec du matériel vidéo Blackmagic Design qui prend en charge la 3D
double flux, vous pouvez créer des clips vidéo pour I'eeil gauche et I'ceil droit en capturant 2 flux de vidéo
HD-SDI simultanément.

= Créez un projet 3D qui correspond a la fréquence d'image de votre source vidéo 3D double flux.
= Assurez-vous que vous avez 2 entrées vidéo HD-SDI séparées connectées au matériel vidéo
Blackmagic.

+ Capturez.



(82 Blackmagic Media Express

En mode d'affichage Liste par timecode, les clips oeil gauche et
oeil droit sont listés sur deux lignes et liés par un indicateur 3D.

Pour capturer de la vidéo en H.265 avec le Blackmagic
UltraStudio 4K Extreme, réglez le format du fichier sur MP4
H.265 dans les préférences de Media Express.

Pour régler le débit binaire de la vidéo compressée en
H.265, appuyez sur le bouton Quality et déplacez le curseur
Encoding settings vers la gauche ou vers la droite.

Lorsque vous capturez et indexez de la 3D double flux dans Media Express, le nom du clip sera appliqué
a la vidéo oeil gauche. Le texte « _right » sera apposé au nom de la vidéo oeil droit. Par exemple, si vous
nommez le clip stéréo « Clip 1 », le clip oeil gauche sera nommé « Clip 1.mov » et le clip oeil droit sera nommé
« Clip 1_right.mov ».

La liste de médias vous donne une indication claire que le clip capturé est un clip 3D :

= En mode d'affichage Vignettes, les clips oeil gauche et oeil droit sont connectés par un indicateur
3D et présentés en tant qu'une seule et grande icone.

* En mode d'affichage Liste par timecode, les clips oeil gauche et oeil droit sont listés sur deux
lignes et liés par un indicateur 3D.

Capturer de la vidéo en H.265
Capturer de la vidéo avec I'encodeur H.265 intégré du Blackmagic UltraStudio 4K Extreme :

Etape 1. Ouvrez le menu Preference de Media Express et réglez le paramétre Capture file format sur
MP4 H.265.

Etape 2. Pour régler le débit binaire de la vidéo compressée en H.265, appuyez sur le bouton Quality et
déplacez le curseur Encoding settings vers la gauche ou vers la droite. Fermez la fenétre Encoding
settingss pour confirmer ce réglage.

Pour plus d'information sur les paramétres de débit et de capture en H.265, consultez la section Encodeur
matériel H.265 de ce manuel.
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Liste de médias Affichage Liste par timecode, Vignettes et Favoris Fonction de recherche Timecode du magnétoscope / périphérique Prévisualisation de la vidéo

[
[
—
[
Nom du projet, format vidéo Chutiers Points d'entrée / Informations Sélection de Canal audio Indicateur de
et fréquence d'image de sortie relatives au clip favoris activer/désactiver contréle a distance
Prendre une Commandes Vu-metres

image fixe de transport
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Gréce aux commandes de transport vous avez la possibilité
de lire ou d'arréter un clip, de passer au clip suivant ou au clip
précédent et de lire vos clips en boucle.

Si le format des clips importés ne correspond pas a celui
des clips existants, on vous demandera de créer un
nouveau projet.

Vous pouvez importer des médias directement, ou les
importer avec un fichier XML ou EDL.

Lecture de fichiers vidéo et audio

Lecture d'un ou de plusieurs clips

Pour lire un seul clip, double-cliquez sur le clip en question dans la liste de médias. Vous pouvez également
sélectionner le clip dans la liste de médias et appuyer sur la barre d'espace de votre clavier ou le bouton
lecture des commandes de transport.

Pour lire plusieurs clips, sélectionnez les clips dans la liste de médias et appuyez sur la barre d'espace de votre
clavier ou le bouton lecture des commandes de transport.

La lecture de votre vidéo aura lieu dans la fenétre de prévisualisation vidéo de Media Express et sur toutes les
sorties vidéo de votre matériel vidéo Blackmagic Design. Durant la lecture, les canaux audio contrélés peuvent
étre activés ou désactivés a l'aide des boutons d'activation et de désactivation situés sous les pistes audio.

Importer des clips

Vous pouvez lire vos fichiers vidéo et audio aprés avoir importé des médias dans Media Express en suivant
I'une des méthodes suivantes :
* Double-cliquez dans une zone vide de la liste de médias.
= Cliquez avec le bouton droit de la souris dans une zone vide de la liste de médias et sélectionnez
la fonction Import Clip a partir du menu contextuel.
« A partir du menu intitulé File, sélectionnez la fonction Import puis Media Files.

Sélectionnez le ou les clips vidéo et audio que vous souhaitez importer a partir de la boite de dialogue intitulée
Open Video Clip. Les clips apparaitront alors dans la zone intitulée Scratch de la liste de médias. Sivous avez
créé vos propres chutiers dans la liste de médias, vous pouvez glisser-déposer les clips dans le chutier désiré.

Si vous souhaitez importer des médias directement dans un chutier, cliquez avec le bouton droit de la souris
dans le chutier désiré et sélectionnez la fonction Import Clip a partir du menu contextuel.

Si les fichiers importés ne coincident pas avec la fréquence d'image et la taille des clips déja existants dans
la liste de médias, une boite de dialogue apparaitra et vous demandera si vous désirez créer un nouveau
projet et sauvegarder le projet actuel.

Media Express prend également en charge l'importation exclusive de fichiers audio multi-canaux enregistrés
a 48kHz aux formats WAVE et AIFF non compressés.

Vous pouvez également importer des fichiers XML provenant de logiciels de montage non linéaire tels que
Final Cut Pro 7 ou Final Cut Pro X. Pour ce faire, allez sur le menu « File », sélectionnez « Import », puis Final
Cut Pro 7 XML ou Final Cut Pro X XML. Lorsque vous ouvrez le fichier XML souhaité, tous les chutiers et les
médias du projet Final Cut Pro apparaitront dans la liste de médias.

Media Express prend également en charge |'importation de fichiers CMX EDL pour capturer des clips en
série en utilisant des fichiers EDL provenant d'autres logiciels vidéo. A partir du menu File, sélectionnez la
fonction Import puis CMX EDL. Sélectionnez le fichier EDL et ouvrez-le.

Les informations relatives au fichier apparaitront dans la liste de médias. Sélectionnez les clips indexés et
effectuez une acquisition en série pour importer les clips a partir de votre magnétoscope.
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Dans la liste de médias, choisissez entre le mode d'affichage
Liste par timecode ou Vignettes. Cliquez sur le bouton favoris
pour ne visualiser que vos clips favoris. Utilisez la fonction de
recherche pour trouver vos clips favoris.

Cliquez sur I'icone d'information de la vignette pour visualiser
sa bulle d'information.

Dans I'onglet Log and Capture, cliquez sur l'icbne « étoile »
située a c6té du champ Name si vous désirez enregistrer un
clip en tant que favori.

Parcourir vos médias

Mode Vignettes

Le mode Vignette est la facon la plus intuitive d'afficher vos clips. Passez votre souris au-dessus d'une vignette
et cliquez ensuite sur l'icdne d'information qui apparaitra au bas a droite de la vignette. Cliquez sur la bulle
d'information pour la minimiser.

Mode Liste par timecode

Vous pouvez afficher vos clips en mode Liste par timecode en cliquant sur le bouton représentant une liste
situé en haut a droite de la liste de médias. Utilisez la barre de défilement horizontale pour visualiser toutes
les colonnes d'information de vos clips.

Création et utilisation des chutiers

Pour créer un chutier, cliquez sur un emplacement vide de la liste de médias avec le bouton droit de la souris
et sélectionnez l'option « Create Bin ». Nommez le nouveau chutier.

Vous pouvez déplacer vos clips en les faisant glisser dans le chutier désiré. Sivous désirez qu'un clip apparaisse
dans plus d'un chutier, importez le méme clip a nouveau en cliquant sur le chutier a l'aide du bouton droit de
la souris puis en choisissant I'option « Import Clip ».

Par défaut, les clips indexés apparaissent dans la section Scratch. Si vous désirez indexer des clips et les
voir apparaitre dans un nouveau chutier, faites un clic-droit sur le nouveau chutier et choisissez I'option
« Select As Log Bin ».

Création et utilisation des favoris

Dans l'onglet Log and Capture, cliquez sur l'icdne « étoile » située a c6té du champ Name si vous désirez
enregistrer un clip en tant que favori.

Dans l'onglet Playback, il vous faudra cliquer sur I'icéne « étoile » lorsque le clip est sélectionné dans la liste de
média pour qu'il soit enregistré en tant que favori. Cliquez a nouveau sur l'icéne « étoile » si vous ne désirez
plus que le clip soit considéré comme un favori.

Licdne des clips marqués en tant que favoris possédera une étoile en mode Liste par timecode et en mode Vignettes.

Cliquez sur le bouton Favoris situé sur le haut de la liste de médias pour n'afficher que vos clips favoris. Licéne
« étoile » deviendra jaune. Tous les clips de votre liste de médias ne seront alors plus visibles sauf ceux qui
avaient été préalablement marqués en tant que favoris.

Associer un clip audio a un clip vidéo
Pour associer un clip audio a un clip vidéo dans la liste de médias :

= Sélectionnez un clip vidéo qui ne contient pas de canal audio.

* Faites un clic-droit sur le clip vidéo et sélectionnez I'option « Link Audio File » a partir du
menu contextuel.
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Sélectionnez un format vidéo pour votre projet en 3D.

La liste de médias vous donne une indication claire que le clip
capturé est un clip 3D.

La liste de médias vous donne une indication claire que les
clips vidéo et audio sont liés.

Utilisez la fonction de recherche pour trouver des clips.

Vous pouvez a présent lire le clip combiné ou le masteriser sur bande.

Supprimer des clips et des chutiers

Pour effacer des clips, sélectionnez les clips non-désirés et appuyez sur la touche "suppression avant" de
votre clavier. Cette opération supprimera les clips de la liste de médias mais elle ne les supprimera pas de
votre disque dur.

Pour supprimer des chutiers, faites un clic-droit dans le chutier et choisissez la fonction « Delete Bin ». Cette
opération supprimera le chutier et tous les clips qu'il contient. Elle supprimera aussi les clips de la liste de
médias mais pas de votre disque dur.

Créer un clip en 3D

Pour ajouter un clip en 3D stéréoscopique dans la liste de médias :

= Sélectionnez un format vidéo pour votre projet en 3D, ce dernier doit avoir la méme fréquence
d'image que votre média 3D.

* Importez le fichier « oeil gauche » dans la liste de médias.

* Faites un clic-droit sur le fichier oeil gauche et sélectionnez l'option « Set Right Eye Clip »
(configurer le clip oeil droit) a partir du menu contextuel. Si le clip oeil droit a été préalablement
capturé par Media Express, le texte « _right » sera apposé a la vidéo oeil droit.

La liste de médias vous donne une indication claire que le clip capturé est un clip 3D. Les clips oeil gauche et
oeil droit sont affichés cote a cote dans la fenétre de prévisualisation vidéo, ce quiindique un projet vidéo en 3D.

Sivous vous apercevez que |'oeil gauche et |'oeil droit d'un clip stéréo 3D ont été téléchargés dans le mauvais sens :

* Faites un clic-droit sur le clip 3D dans la liste de médias.

= Sélectionnez l'option « Swap Eyes » a partir du menu contextuel.

Effectuer une recherche dans la liste de médias

Vous pouvez aisément retrouver des clips appartenant a un projet en saisissant le nom de vos clips dans la
fonction de recherche qui se trouve sur le haut de la liste de médias. Lorsque cette fonction est utilisée en
conjonction avec la fonction favoris, la recherche sera limitée a vos clips favoris, c'est pourquoi la liste de clips
trouvés sera plus courte.
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Cliquez sur l'icone étoile située en haut de la liste de médias
pour n'afficher que vos clips favoris.

Deux clips ont été sélectionnés pour étre acheminés
sur bande.

Choisissez le nombre de canaux audio a masteriser.

Monter des fichiers vidéo et audio sur bande

Bien que l'on parle communément de master sur bande, cela n'a aucune importance si votre magnétoscope
utilise une bande ou un disque. Pour masteriser vos clips :

= Sélectionnez les clips que vous souhaitez envoyer sur bande.
* Cliquez sur l'onglet bleu « Edit to Tape ».

= Configurez le point d'entrée et le type de montage.

= Enregistrez votre master sur bande.

Sélectionner les clips a masteriser

Choisissez le ou les clips que vous souhaitez masteriser a partir de la liste de médias. Vous pouvez méme
insérer des clips audio multi-canaux pour remplacer la piste audio principale sur la bande originale. Si vous
souhaitez envoyer vos clips favoris sur bande, cliquez sur l'icdne étoile située en haut de la liste de médias
pour révéler vos clips favoris et masquer tous les autres. Puis, sélectionnez les clips favoris que vous désirez
envoyer sur bande.

Insertion et assemblage sur bande

Cliquez sur l'onglet bleu Edit To Tape. Saisissez le point d'entrée de la bande en saisissant le timecode dans
le champ In, ou en positionnant la bande sur le point désiré au moyen des commandes de transport puis en
cliquant sur le bouton Mark In.

Sile point de sortie n'a pas été saisi, la durée du montage sera équivalente a la longueur totale des clips situés
dans la liste de médias. Si un point de sortie a été défini, Media Express arrétera l'enregistrement une fois le
point de sortie atteint, méme si certains clips n'auront pas encore été acheminés.

Choisissez d'effectuer un master sur bande a l'aide d'un montage par assemblage ou par insertion. Appuyez
ensuite sur le bouton Master.

Le mode Preview simule le processus de montage mais n'enregistre rien sur la bande. Ce mode vous permet
de vérifier le point de montage. La prévisualisation des opérations de montage devrait toujours étre vérifiée
sur des moniteurs directement connectés a la sortie du magnétoscope. Cela vous permet de visualiser la
vidéo déja présente sur la bande conjointement avec la nouvelle vidéo.

Si le taquet de protection contre l'enregistrement du magnétoscope ou de la cassette est activé, Media
Express vous l'indiquera lorsque vous cliquerez sur le bouton Master. Déplacez le taquet avant de réessayer.

Sélectionnez les canaux vidéo et audio que vous souhaitez acheminer au moyen des boutons permettant
d'activer et de désactiver les pistes. Désélectionnez le canal vidéo si vous désirez acheminer uniquement
de l'audio.
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Ouvrez le menu de configuration en cliquant sur l'icéne
de la roue dentée.

Qu'est-ce que le Blackmagic Disk Speed Test ?

Le Blackmagic Disk Speed Test mesure les performances de lecture et d'écriture des supports de stockage
en formats d'image vidéo. Disk Speed Test est inclus avec le logiciel Desktop Video et peut étre téléchargé
gratuitement sur le site Internet de Blackmagic Design. Accédez aux paramétres du Disk Speed Test en
cliquant sur l'icdne représentant une roue dentée, située juste au-dessus du bouton Start.

Sélectionner le disque cible
Cliquez surlafonction Select Target Drive et assurez-vous que vous possédez les permissions de lecture et d'écriture.

Sauvegarder une capture d'écran
Cliguez sur la fonction Save Screenshot pour sauvegarder une capture d'écran des résultats.

Fonction Stress
La fonction Stress peut étre configurée entre 1GB et 5GB par tranches de 1 GB. 5GB est le paramétre par
défaut et fournit les résultats les plus précis.

Aide Disk Speed Test
Cliquez sur la fonction Disk Speed Test Help pour lancer la version PDF du manuel de Disk Speed Test.

A propos de Disk Speed Test
About Disk Speed Test affiche la version du Disk Speed Test en cours d'utilisation.

Bouton Start

Cliquez sur le bouton « Start » pour commencer le test. Disk Speed Test écrit puis lit un fichier temporaire sur
le disque cible sélectionné. Disk Speed Test continue a écrire et a lire jusqu'a ce que vous arrétiez le test en
cliguant a nouveau sur le bouton « Start ».

Will it Work?

Le tableau « Will it Work? » liste les formats vidéo courants et affiche une coche ou une croix pour indiquer
si la performance du disque est adéquate. Répétez le test plusieurs fois pour révéler les formats vidéo pour
lesquels la performance du disque se situe sur la limite. Si un format vidéo présente tantét une coche et
tantot une croix, cela vous indique que le disque de stockage ne peut pas prendre en charge le format vidéo
de maniere fiable.

How Fast? (FPS)

Le tableau de résultats How Fast? (FPS) affiche les fréquences d'images que votre disque peut atteindre et
se lit conjointement avec le tableau Will it Work?. Si le tableau Will it Work? affiche une coche verte pour 2K
DCI 25p en YUV 4:2:2 10 bits, mais que le tableau How Fast? (FPS) indique une fréquence d'images maximale
de 25i/s, cela signifie que les performances du support ne seront pas fiables.



(I8 Blackmagic Disk Speed Test

r

Bouton START

Cliquez une fois sur ce
bouton pour commencer la
vérification de la vitesse du
disque. Cliquez sur le méme
bouton pour terminer le test

\
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Will it Work?

Ce tableau affiche les
formats vidéo qui peuvent
étre pris en charge par
votre disque de stockage

\

Parametres

Cliquez sur ce bouton pour
accéder aux parametres
avant d'exécuter une
vérification de la vitesse
du disque

How Fast (FPS)?

Ce tableau affiche les
résultats en images par
seconde (i/s)
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